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CHAPTER 1
Getting Started with CIFS-ECS Tool 

The EMC® CIFS-ECS Tool provides a local file system interface through which you can 
store and retrieve files on an EMC Elastic Cloud Storage™ (ECS) appliance. Use 
CIFS-ECS to store and retrieve files (such as pictures, movies and documents) in the 
cloud using the same applications and tools that you use today.

◆ Prerequisites .......................................................................................................... 6
◆ Step 1: Downloading and installing CIFS-ECS software .........................................  7
◆ Step 2: Configuring the CIFS-ECS folder .............................................................. 9
◆ Step 3: Testing your configuration .......................................................................  15
◆ Step 4: Using CIFS-ECS ......................................................................................  15
◆ Troubleshooting CIFS-ECS ..................................................................................  24
◆ Upgrading CIFS-ECS ...........................................................................................  26
◆ Uninstalling CIFS-ECS.........................................................................................  27
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Prerequisites
Before you install CIFS-ECS, make sure that your computer meets these minimum 
requirements: 

◆ Your Windows computer is running one of these operating systems: 

Supported Windows Client versions:

 Windows 7 (x64)

 Windows 8 or 8.1 (x64)

 Windows 10 (x64)

Supported Windows Server versions:

 Windows Server 2008 R2 (x64)

 Windows Server 2012 (x64)

 Windows Server 2012 R2 (x64)

 Windows Server 2016 (x64)

Supported Microsoft Cluster Services:

 Windows Server 2008 R2 

 Windows Server 2012 

 Windows Server 2012 R2 

 Windows Server 2016 

Note: To verify the version of Windows running on your computer, double-click the 
My Computer icon on your desktop and select Help > About Windows.

◆ Elastic Cloud Storage (ECS) appliance version is 2.2.1 or later, or 3.0 or later.

◆ You have Microsoft .NET Framework 4.5.2 Web installed. If it is not installed, 
during the CIFS-ECS installation procedure, you wil l be prompted to install it. 

◆ You have the correct version of CIFS-ECS software: 
EMC-CIFS-ECS.<ver>_x64.exe (64-bit).

◆ You have administrative privileges on the Windows computer where you want to 
install CIFS-ECS.

◆ You have the following information from your Service Provider: 

 ECS Object user credentials (User ID and secret key) for CIFS-ECS.

 One or more IP addresses or resolvable hostnames for the ECS system you 
wil l access, DATA IP addresses for an ECS system that has implemented 
Network Separation, or the address of the load balancer that is managing the 
ECS Server. 

A separate load balancer is optional depending on your deployment, since 
CIFS-ECS includes a built-in load balancer.
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 The proxy server IP address and port, and a username and password if you are 
required to use a proxy server by your Service Provider.

◆ If you intend to collect SNMP traps from CIFS-ECS, SNMP must be enabled on 
the system before installing CIFS-ECS (refer to “Log options” on page 38 for 
details).

Best Practices

The following are recommendations for using CIFS-ECS in a home or office 
environment:

◆ CIFS-ECS is optimized for sending small to medium size files (of less than 4 
Gigabytes) to the cloud. Placing large files in the cloud may require very long 
upload and download times based on your network speed. 

◆ CIFS-ECS can be installed on multiple systems using the same credentials. This 
means that the files you upload to the cloud can be viewed (and edited or deleted) 
on any system with the same CIFS-ECS credentials. As a best practice, manage 
your cloud environment so that users are not accessing the same files at the same 
time. This reduces the risk of one user overwriting another user's changes.

◆ Exclude files managed by CIFS-ECS from your Windows backups. The reasons are:

 The files are already backed up in the ECS cloud. 

 Backing up a stub file does not provide any value, since it is a shortcut 
representation of an inactive file stored in the ECS cloud.

 The Windows backup operation may cause all of the stub files to be restored. 
Restoring stub files takes time depending on the number of stub files and the 
file sizes, and may delay the Windows backup operation. The interaction 
between the Windows backup operation, the restored files, and the ECS cloud 
causes performance thrashing between your system and the ECS cloud. This 
may also exhaust the system disk space and the network connection 
bandwidth.

◆ Attempting to run applications such as .exe (executable) files from within 
CIFS-ECS is not supported.

◆ Pointing a database/SQL application to a CIFS-ECS drive is not supported.

Step 1: Downloading and installing CIFS-ECS software
Perform the following steps to download and install the CIFS-ECS software:

1. Go to the Support website https://support.emc.com and download the CIFS-ECS 
software. Save it to a folder on your Windows computer.

If necessary, contact your Service Provider or Support to obtain the CIFS-ECS 
software.

2. Using Windows Explorer, navigate to the location of the CIFS-ECS executable, 
then double-click it to start the CIFS-ECS setup wizard.

3. Select the language to be used during installation and click OK. CIFS-ECS 
prepares the setup wizard. 

http://support.emc.com


8 EMC CIFS-ECS Tool User Guide

Getting Started with CIFS-ECS Tool

If your language is not listed as a choice, the default is English. You can also 
change the language after the installation is completed as described in “Changing 
the CIFS-ECS language settings” on page 19.

4. If you receive an InstallShield Wizard prompt to download and install Microsoft 
.NET Framework 4.5.2 Web with a status of Pending, click Install.

If the installation of Microsoft .NET Framework 4.5.2 Web fails, download the 
software from the Microsoft website, install it, and restart the CIFS-ECS setup 
wizard (step 2).

5. If you receive an InstallShield Wizard prompt to download and install Microsoft 
Visual C++ Redistributable package, click Install.

If the package installation fails, download the software from the Microsoft website, 
install it, and restart the CIFS-ECS setup wizard.

Note: If the C++ redistributable package stil l fails to install, be sure to uninstall it. 
Then, run Windows Update and ensure the system is up to date, and restart the 
CIFS-ECS setup wizard again. 

6. Click Next. You are asked to accept the license agreement. 

7. Choose I accept the terms of the license agreement, then click Next. The setup 
wizard exits if you do not accept the license agreement. 

8. Accept the defaults or fil l in the fields as follows, then click Next:

The Installation screen appears.

9. Clear or accept the optional setting for the Enable CIFS-ECS Feedback checkbox 
and click Install. Select the Enable CIFS-ECS Feedback checkbox to send 
anonymous configuration information to Support.

The wizard begins installation. This may take several minutes. The Setup Wizard 
Completed screen appears.

If you are performing the installation and receive the message “This setup is unable 
to automatically close all requested applications”, consult “Troubleshooting 
CIFS-ECS” on page 24 for a resolution.

10. Click Finish. 

The CIFS-ECS Console (and the CIFS-ECS Drive Parameters dialog) opens.

Table 1  CIFS-ECS folder descriptions

Field What to enter

Install CIFS-ECS 
to

The path to the local Windows folder where you install the CIFS-ECS software. The default 
location is: 
C:\Program Files\CIFS-ECS\

Accept the default or click Change to select a different location. 

Data Directory The path to the local Windows folder that contains files used internal ly by CIFS-ECS and also 
used as the default directory for data copied to and from ECS. The default location is: 
C:\ProgramData\CIFS-ECS Data\

Accept the default or click Change to select a different location.
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11. Proceed to “Step 2: Configuring the CIFS-ECS folder.” 

Step 2: Configuring the CIFS-ECS folder
Designate the location on your computer where you store files in the cloud. CIFS-ECS 
uses a mapped drive so a cloud connection is established whenever the computer is 
turned on.

Note: By default, CIFS-ECS uses the language selected during installation. Directions 
for changing the language used by CIFS-ECS are provided in “Changing the CIFS-ECS 
language settings” on page 19. 

1. The CIFS-ECS Drive Parameters dialog should be open on your desktop. If not, 
click Add CIFS-ECS Drive from the Home tab on the CIFS-ECS Console (Start > 
All Programs > CIFS-ECS).

The CIFS-ECS Drive Parameters dialog allows you to select any unused drive letter 
to assign to CIFS-ECS, and to select how you want your files stored. A description 
of the available options is provided in Table 2 on page 9.

Note: Use the default CIFS-ECS parameter settings unless your Service Provider 
recommends otherwise.

2. Fil l in the fields described in Table 2 based on recommendations from your Service 
Provider.

Table 2  CIFS-ECS Drive Parameter options  

Field What to do

CIFS-ECS Drive Select any available Windows drive letter from the drop-down window to use as the CIFS-ECS. 
Selecting a drive letter is optional. 
If you select none, then you wil l access the files through the cache path (the local directory 
where the files stored). You set the cache path later for step 12 on page 13.

Description Enter a description that wil l help you remember this drive’s use (“Cloud_Drive” for example). 

Local Storage Options

Radio button: 
Replace 
recently 
un-accessed 
files with a stub 
file that points 
to a full copy of 
the data in the 
cloud

Required, selected by default. This button indicates the push-to-cloud mode. In this mode, the 
files you placed on the CIFS-ECS drive are pushed to the ECS cloud after a period of inactivity 
and replaced with a shortcut (called a “stub”) on the local machine that knows how to retrieve 
the data from the cloud. This mode does not require as much space on the local file system, but 
it might mean that there is a delay when accessing files, or that some files might be temporarily 
unavailable if the network connection to the cloud is lost. 

Metadata Metadata defines how a file is treated when it gets uploaded to the cloud. The policies that 
govern file handing are set by your Service Provider. Refer to “Modifying CIFS-ECS metadata” 
on page 34 for details on adding metadata tags to your files.

Excludes Lets you specify the files that CIFS-ECS should not store in the ECS cloud. You can specify 
individual files, file patterns, folders, folder patterns, or as a file path. For more information 
about how to specify files, folders and file paths, see “Specifying files to exclude from the ECS 
cloud” on page 37. 
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3. Click Next. The Settings dialog appears. 

4. In the Settings dialog, expand the Hosts drop-down list.

 If your host is listed in the Hosts drop-down list, select your host and proceed 
to step 11 on page 11.

 If your host is not listed in the Hosts drop-down list, you need to create a new 
host record entry for it. Proceed with step 5.

5. In the Settings dialog, click the Hosts button to open the Hosts dialog.

6. Click Add. 

7. Fil l in the fields for the General tab, as described in Table 3 on page 10, based on 
the instructions from your Service Provider. 

Table 3  General Server details descriptions  

Field What to do

Server Name Enter a descriptive name to help you identify which cloud host this configuration represents.

Description Enter an optional description of the cloud host. 

Server type Select ECS to use an ECS server or Virtustream to use the Virtustream server.

Notice: If you select Virtustream, the fol lowing CIFS-ECS Tool features are not supported: 
Versioning and the associated File Restore functionality, Windows/ECS Account translation, 
and Retention.

User ID Enter the S3 User ID supplied by your Service Provider. For ECS, this is ECS Object User.

Secret Access 
Key

Enter the secret access key supplied by your Service Provider.

Port Override (Optional) Set to 9020 (HTTP) or 9021 (HTTPS), which are the default ports ECS uses for S3 
REST. It can be modified if ECS is using a different port. 

Host Name/IP Enter one or more IP addresses or resolvable host names of the target ECS system, or the 
address of the load balancer that is managing the ECS Server. If HTTPS is selected, this field 
must contain a host name, not an IP address. 
For an ECS system that has implemented Network Separation, enter one or more DATA IP 
addresses; otherwise, use the public IP addresses.
This information is supplied by your Service Provider. Click Add.

Test Use the Test button to test the connection between the CIFS-ECS host and the cloud. 
In the case of HTTPS, if the ECS certificate is not signed by a well-known Certificate 
Authority, clicking Test presents the certificate details and gives you the option of instal ling 
that certificate into the Trusted Certificate Authority store. After instal ling the certificate, click 
Test again and you should receive a “success” message. You should click Install only if the 
certificate indicates it is the correct server. If you get an error message, proceed to 
“Troubleshooting CIFS-ECS” on page 24.
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8. Switch to the Advanced tab. Fil l in the Advanced tab fields as follows, based on 
the instructions from your Service Provider:

9. Click OK. 

10. In the Hosts dialog, verify that the values are accurate, highlight the host entry and 
then click Select. The Settings dialog reappears.

11. Complete the fields in the Settings dialog as follows:

Table 4  Advanced Server details descriptions  

Field What to do

Enable 
Throttling

(Optional) Throttling limits the speed at which data is sent to and from the cloud. If throttling 
is disabled, data is sent and received as quickly as possible. You may want to enable throttling 
if CIFS-ECS is using all available bandwidth and Internet access for other applications 
becomes too slow.

Download 
Throttle 
(Kbytes/sec)

If you enabled throttling, enter an upper limit to the download speed in kilobytes per second.

Upload Throttle 
(Kbytes/sec)

If you enabled throttling, enter an upper limit to the upload speed in kilobytes per second.

Configure Proxy 
Server

If your Service Provider supplied you with proxy server information, click this button to 
configure CIFS-ECS to communicate with the cloud through a proxy server. The proxy server 
IP Address and Port, and the Username and Password that you use to access your network 
are required. 
If you currently use a proxy server, click Import to import the proxy server address and port 
information from your current Internet Explorer configuration. You will stil l need to provide 
your username and password.
To use a default proxy server that is defined by the netsh winhttp command, select the Use 
default proxy if defined checkbox, leave the Address, Port, Username, and Password fields 
blank, and click OK. If the checkbox is not selected, the proxy server defined by netsh winhttp 
is ignored.

Select Allowed 
HTTPS 
Protocol

Choose which HTTPS protocols to support for an ECS host. Choose Override Default 
Protocol and then select the desired protocols.

Ignore HTTPS 
Errors

If you are receiving certain SSL errors that cannot be easily fixed, select one or more of the 
following checkboxes to temporarily resolve the errors. Use these options only as temporary 
solutions, because selecting any one of them wil l likely make the connection less secure:
 SSL certificate common name is incorrect — For HTTPS, al lows the use of an IP address, if 

you cannot use the host name that is in the certificate. For HTTPS, you must use the same 
host name that is in the certificate. This means that you cannot use an IP address. Selecting 
this checkbox allows the use of an IP address.

 SSL certificate has expired — Allows a connection even if the certificate is expired.
 Ignores unknown certificate authority problems — Allows the use of a certificate even if it 

does not resolve to a Trusted Root Certification Authority.
 Ignores incorrect usage problems — Allows the use of a certificate even it is the wrong 

type of certificate.
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Table 5  Settings descriptions  

Field What to supply 

CIFS-ECS 
Drive

Displays the drive that you mapped in step 2 on page 9.

Host 
(required)

Select the cloud host to which to map this CIFS-ECS. The drop-down menu displays the hosts 
that you configured.

Bucket 
(required)

Select an existing bucket from the drop-down list, or enter a new bucket to be created.

Protect files 
with 
checksums on 
all uploads

Enabling this option causes CIFS-ECS to create a unique checksum for each upload to the 
cloud. The checksum can then be verified by the cloud host to ensure that the data is valid. 

Track Folder 
Security

Enable this feature to al low CIFS-ECS to synchronize security descriptors for folders on ECS. 
Note that security descriptors for files are always saved. This feature enables the transfer of 
folder-level security descriptors to a new Windows server so that all copies of the cloud drive 
have the same folder-level access control list (ACL).

Write al l files 
and folders to 
ECS in 
lowercase

Preserving upper and lowercase filenames on ECS can incur a performance penalty. When this 
option is enabled, the original filename case is preserved on Windows and the filenames are 
stored in lowercase on ECS.

Synchronous 
Upload

When enabled, CIFS-ECS uploads your local file to the cloud after you modify it as your 
application (Notepad or Word, for example) is closing the file and also writes the file to your 
local disk.
When Synchronous Upload is selected, the setting for Modify Wait Time in the Advanced 
Options dialog is ignored.

Translate 
ECS/Window
s Permissions

When enabled, this option translates the Windows permissions into an equivalent ECS/S3 ACL 
when uploading a file to a CIFS-ECS cloud drive. “Translating ECS/Windows permissions” on 
page 46 provides complete information.

USN Journal Optional, click USN Journal to enable express recovery if the current state displayed in this 
Settings dialog is: USN Journal File Not Active. 
In the USN Journal File Maintenance dialog, accept the defaults or supply values for the New 
Maximum Size and New Allocation Delta fields. Click OK. “Enabling express recovery with 
USN Change Journal” on page 32 provides more information about express recovery.

Versioning Click Versioning to assign S3 versioning to the folder selected in the Bucket field. In the 
Versioning State dialog, click the Change Versioning State checkbox, Enable, and OK. 
When enabled, CIFS-ECS can save versions of the folder contents as well as restore specific 
older versions that have been deleted or overwritten. The current state of versioning is 
displayed in this Settings dialog: Enabled, Suspended, or blank (has never been set). 
“Recovering files” on page 20 provides instructions for recovering files.
Also, in the Versioning State dialog, you can define life cycle rules. In the Life Cycle Rules list, 
you can select an existing rule and click Edit to modify it or Delete to remove it.
You can select Add to define a new rule as described in “Defining new or modifying existing life 
cycle rules” on page 17. 

Notice: If you selected Virtustream as a server type, Versioning is not supported.
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12. In some situations your Service Provider may suggest that you modify CIFS-ECS 
settings that control the frequency and speed at which files are transferred to the 
cloud. If you do not need to modify the advanced settings, click Next and proceed 
to step 13 on page 13. If you do need to check or modify these settings, click 
Advanced. The Advanced Options dialog displays. 

Your Service Provider can provide guidance on changing these values as required. 
Table 6 on page 13 describes each field and its use.

13. If you are accepting the defaults, click Cancel to exit the dialog without making 
changes or click OK after making changes and then click Next.

Table 6  Advanced settings descriptions 

Field Description

Local Cache Location

Specifies the location on the local machine where the local files are stored. This folder is synchronized with the 
cloud. The default location for this folder varies based on your Windows operating system. You can modify this 
location when you create the cloud folder but, once the folder is created, it is fixed. It can refer to any NTFS or 
ReFS volume, but cannot specify the root of the volume. 

Modify Wait Time
Delay after file is last modified before uploading it to the cloud. Default = 1 minute.

Specifies the amount of time that CIFS-ECS waits after you modify a local file before it updates the cloud with 
your changes. 

Access Wait Time Upload
How long to wait before replacing local file with a stub. Default = 1 day.

Specifies the amount of time after a file is last accessed before it is replaced with a stub on the local file 
system. 

Access Wait Time Restore
How long to wait before replacing local file with a stub after restore . Default = 1 day.

Specifies the amount of time after a file is restored that the CIFS-ECS waits to replace it with a stub. 

Access Wait Time if free disk space is below
Allows you to set more aggressive file stubbing when disk space is low.

When disk space is low, it is a good idea to speed up the stubbing process to guard against running out of disk 
space. Use these options to set one or two levels of faster stubbing. For example, you can set up one option to 
stub a file every two hours when disk space is below 50 GB and set the second option to stub after a minute 
when disk space falls below 5 GB.

Update Wait Time
How long to wait before checking the cloud for updated content. Default = 1 day.

Specifies the amount of time that the CIFS-ECS waits to check if a file or directory was updated on the cloud 
via another source. If a change or addition is found in ECS that does not exist locally, the local information is 
updated. Modifying this setting may be useful if you are accessing ECS via different systems or access 
methods, but is not applicable to a single user using a single computer to access their data.

Open Wait Time
Maximum time to wait for a file to close before uploading a copy to the cloud. Default = 1 hour.

Specifies the maximum time to wait for a file to close before CIFS-ECS uploads a copy of the file to the cloud. 
If the file does not close within this time period, a shadow copy is created of the volume and a copy of the file 
is made and uploaded to the cloud from the shadow copy. Once the file is closed, it waits the “Modify Wait 
Time” before uploading the final copy of the file to the cloud.
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14. Complete the fields in the Logging tab to configure file system logging for the 
cloud drive.

15. Click Finish. The CIFS-ECS Console now displays the new drive and after a few 
seconds, the red icon turns green if al l settings are correct.

16. Optionally, once you have created the CIFS-ECS drive, you can add a shortcut to 
your desktop for the drive you just created. This is the location where you place 
and retrieve the files you send to the cloud. Add a shortcut as follows:

a. From your desktop or Start menu, click My Computer, right-click on the drive 
you assigned as your CIFS-ECS, and select Create Shortcut. 

b. A dialog opens asking if you want to place the shortcut on your desktop, click 
Yes.

You can now click on the desktop shortcut to open the drive folder where you 
place the files you send to the cloud.

17. Proceed to “Step 3: Testing your configuration” to test the connection between 
CIFS-ECS and the cloud.

Table 7  Logging tab descriptions 

Field What to supply 

Enable File 
System 
Logging

Select the checkbox to enable file system logging for the cloud drive.

Path Is the folder where the log files are written. Accept the default location (for example, 
C:\ProgramData\CIFS-ECS Data\G_DriveFSLog) or specify another location (for example, 
H:\G_DriveFSLog).
For performance reasons, this folder should be on a different physical drive than the drive 
hosting the cloud drive data.

Maximum Log 
Size

Enter the maximum size of a log file (default=10 MB). 
When a log file reaches the maximum size, CIFS-ECS closes it and creates a new log file.

Maximum Log 
Files

Enter the maximum number of log files (default=100). If the total number of files exceeds this 
amount, CIFS-ECS deletes the oldest log files.

Minimum Free 
Space

Enter the minimum amount of free space for the log files (default=2048 MB).
CIFS-ECS monitors the amount of free space on the volume holding the log files. If the amount 
of free space is less than this value, CIFS-ECS deletes the log files (oldest first) to keep the 
free space above this value.

Action 
checkboxes

Select the checkboxes for the file system actions that you want to write to the log file:
 CIFS-ECS Operations.
 Folder Synchronize.
 Delete and Rename.
 Create.
 Data update.
 Attribute update.
 Permission update.
“File system logging” on page 48 provides detailed information about the file system actions, 
log naming convention, and log contents.
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Step 3: Testing your configuration
CIFS-ECS should now be configured and connected to the cloud. The final step in the 
setup process is to test the configuration to ensure that it is functioning correctly.

Open your CIFS-ECS application by selecting Start > All Programs > CIFS-ECS or by 
right-clicking the CIFS-ECS icon in the Windows Toolbar at the bottom of your screen 
and selecting Open.

CIFS-ECS has an active connection to the cloud host if the icon to the left of the cloud 
host description is green. If the icon is red, there is an issue with the connection 
between your CIFS-ECS and the cloud host. The “Troubleshooting CIFS-ECS” on 
page 24 wil l help you determine the cause of the problem.

Switch to the Status tab on your CIFS-ECS Console and select the Info and Activity 
Window checkboxes. These allow you to monitor the status and performance of 
CIFS-ECS.

Complete the following simple tests to verify your configuration:

1. Open your CIFS-ECS folder (from My Computer or click the CIFS-ECS shortcut 
on your desktop if you created a shortcut to the drive).

2. Click the Transfer Status icon in the CIFS-ECS menu bar to open a window that 
shows you the current upload progress.

3. Copy several files into the folder.

Based on your settings and connection speed, you should see a blue bar in the 
Bytes Sent graph in the CIFS-ECS Activity window as well as files and their upload 
status appearing in the Transfer Status window. Eventually al l of the files you 
placed in the CIFS-ECS folder should appear in the CIFS-ECS Console Message 
window as uploaded to the cloud. 

If the log messages never appear, make sure you are displaying Informational 
Messages. Also, check Options > Log to verify that it is set to log all uploads.

4. If the upload was successful, CIFS-ECS is functioning correctly. If the upload was 
unsuccessful, proceed to “Troubleshooting CIFS-ECS” on page 24.

Step 4: Using CIFS-ECS
CIFS-ECS is extremely easy to use on a day-to-day basis. You can send files to the 
cloud, modify and rename files, and have files you sent to the cloud from another 
computer (but with the same user ID) appear in your CIFS-ECS folder. 

Use the following steps to send files to the cloud:

1. At the beginning of your session (for example, when you start or reboot your 
computer), open your CIFS-ECS Console. To do so, select Start > All Programs > 
CIFS-ECS or right-click the CIFS-ECS icon in the notification area of the Windows 
taskbar and click Open.

2. Check to make sure the host icon is green, signifying that CIFS-ECS has a 
connection to the cloud.



16 EMC CIFS-ECS Tool User Guide

Getting Started with CIFS-ECS Tool

3. Double-click on your cloud drive desktop shortcut icon to open the CIFS-ECS 
folder connected to the cloud.

4. Copy files to send to the cloud into this folder just as with any other location. 

5. At any time, you can right-click on the CIFS-ECS icon in the notification area of the 
Windows taskbar at the bottom of your screen and select Transfer Status to view 
the current status of your file transfers.

Based on your CIFS-ECS settings, you should also see the files appear as 
“uploaded” in the message pane of the CIFS-ECS Console. This may take an 
extended period of time if you set your CIFS-ECS to only update the cloud 
infrequently (refer to Table 6 on page 13).

Checking the transfer status of your CIFS-ECS files

CIFS-ECS allows you to view the status of any file you placed in the CIFS-ECS folder. 
Simply right-click on the file and select Properties > CIFS-ECS. The upload location 
of the file, upload time, and time it was “stubbed” is displayed. 

You can also right-click the CIFS-ECS icon in the notification area of the Windows 
system tray (usually at the bottom of your screen) to open the transfer status window. 
In addition, the CIFS-ECS icon displays an up or down arrow to indicate current 
activity.

Pausing or forcing an upload to the cloud

In the event that you need to manually pause (or restart a CIFS-ECS upload), simply 
right-click on the appropriate drive on the CIFS-ECS Console and click Pause. This 
temporarily stops the file upload to the cloud. Click Pause again to deselect it to 
resume the upload. (This option is also available from the Pause Upload button on the 
CIFS-ECS menu bar.)

You can force an upload of updated files immediately (instead of waiting for CIFS-ECS 
to upload files based on the schedule you set when you configured the drive), by 
right-clicking the appropriate drive on the CIFS-ECS Console and clicking Force 
Upload. A message displays if there are no files that need to be uploaded in the queue. 
(This option is also available from the Force Upload icon on the CIFS-ECS menu bar or 
by right-clicking on a folder in CIFS-ECS and selecting CIFS-ECS > Force Upload.)

If there are a substantial number of files ready for upload, CIFS-ECS wil l manage the 
upload queue:

◆ CIFS-ECS wil l add files to the upload queue at each scan so long as the queue is 
not greater than 10,000 files. It wil l continue to do so until al l files are uploaded.

◆ The upload list on the Home tab wil l list the first 100 files awaiting upload and 
show a red tag that indicates more files are awaiting upload.

Manually disconnecting a drive

You can disconnect a drive from the cloud by right-clicking the drive and selecting 
Manual Disconnect. This immediately disconnects the drive from the cloud. Click 
Manual Disconnect again to al low CIFS-ECS to reconnect to the ECS cloud. (This 
option is also available from the Manual Disconnect button on the CIFS-ECS menu 
bar.)
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Opening a cloud drive in Windows Explorer

You can view the root folder of your cloud drive in Windows Explorer by clicking the 
Show in Explorer button. You can also choose this option by right-clicking the cloud 
drive.

Forcing files to be stubbed

You can force files to be stubbed immediately (instead of waiting for CIFS-ECS to stub 
the files based on the schedule you set when you configured the drive), by 
right-clicking the appropriate drive in the CIFS-ECS Console and clicking Force Stub. 
A message displays the number of files that need to be stubbed in the queue.

This option is also available at the directory level by right-clicking a directory and 
selecting CIFS-ECS > Force Stub.

File management

You can perform operations on an entire CIFS-ECS drive from the CIFS-ECS Console 
(as mentioned above) or at the directory or file level. The following options are 
available by right-clicking a directory or a file and selecting CIFS-ECS from the 
drop-down menu:

◆ Force upload — Upload updated files immediately instead of waiting for CIFS-ECS 
to upload files based on the schedule you set when you configured the drive.

◆ Add tag — Set the user metadata for al l subdirectories and/or specific files based 
on the characters in the filename (for example, al l text files could be tagged using 
*.txt). Refer to “Modifying CIFS-ECS metadata” on page 34 for details.

◆ Bulk file restore — Restore stubbed files in the selected directory from the cloud. 
Bulk file restore enables multiple files to be restored in parallel, allowing better 
bandwidth utilization and faster file restoration.

◆ Recall al l directories — Recreates the directory and file structure from the cloud 
onto your local drive.

◆ Force stub — Force files to be stubbed immediately instead of waiting for 
CIFS-ECS to stub the files based on the schedule you set when you configured the 
drive.

Defining new or modifying existing life cycle rules

To define new life cycle rules or to modify existing rules, perform this procedure:

1. In the Settings dialog, click Versioning. The Versioning State dialog appears.

2. Ensure that the Change Versioning State checkbox and Enable are selected. 

3. Click Add to define a new rule or select an existing rule and click Edit. The Rule 
dialog appears.
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4. Complete or modify the fields as follows:

 Required, for a new rule, type the name or a descriptive identifier in the Rule ID 
field.

 Optional, specify the path for the folder to which the rule applies. 

– If you supply a path, the rule applies to the folder, its contents, and any 
subfolders. 

– If this field is blank, the rule applies to al l objects in the bucket.

 Required, select the Enabled checkbox.

 Set the expiration time.

– For current objects, either select Days and type the number of days from 
creation (for example, 60) at which point an object is deleted or select Date 
and select an expiration date.

– For non-current (old versions) objects, type the number of days from 
creation at which point an object is deleted.

For current objects, ensure that the expiration time for each rule does not 
conflict. Two conflicting rules with overlapping expiration times cause the 
second rule to fail with an Internal Error.

 Click OK.

5. Click OK in the Versioning State dialog.

Monitoring CIFS-ECS performance

CIFS-ECS provides an Activity Window and a Performance Monitor that al low you to 
monitor the performance of your cloud environment:

◆ Activity Window — Displays information about the state of the current 
connection to the ECS host. Use this as a quick way to verify that the CIFS-ECS 
service is up and running. 

Enable the Activity Window from the CIFS-ECS Console by selecting the Status 
tab > Activity Window. The Activity Window appears on the right side of the 
CIFS-ECS Console. During periods of activity (during uploads and downloads for 
example), the window displays statistics such as bytes sent, bytes received, 
number of files in the upload queue, and so on.

◆ Windows Performance Monitor — Provides a detailed view of CIFS-ECS activity 
both in real time and by collecting log data. 

Enable the Performance Monitor from the CIFS-ECS Console by selecting the 
CIFS-ECS icon next to the Home tab and then selecting Performance Monitor. 
The utility opens in a separate window. 

The Window Performance Monitor is a utility provided as part of your Windows 
operating system. Directions for its use are available from the Help drop-down 
menu in the Performance Monitor toolbar.
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Changing the CIFS-ECS language settings

The language used by the CIFS-ECS console was selected during installation. After 
installation you can change the language used by CIFS-ECS as follows:

Note: Changing the language requires a CIFS-ECS restart during this procedure.

1. From the CIFS-ECS Console, select the CIFS-ECS icon next to the Home tab and 
then select Set Language. The Select language screen displays.

2. Select a language in the drop-down menu and click OK.

Note: If this language was not part of the original CIFS-ECS installation, you may 
be required to install the appropriate language pack by your Service Provider. Once 
the language pack is downloaded to your system, click Add Language Pack to 
select the new language pack and then OK.

3. A message confirming your selection appears. Click Yes.

Note: If an Access Denied message appears, close CIFS-ECS and restart 
CIFS-ECS as an Administrator as follows:
Open the CIFS-ECS application by selecting Start > All Programs and then 
right-click CIFS-ECS, and select Run as Administrator. Complete step 1 through 
step 3.

4. CIFS-ECS restarts and the language used by the console changes to your 
selection.

Examples of languages for the installer or as language packs
By default, the CIFS-ECS installer uses the language specified for the operating 
system on the local system. Depending on the CIFS-ECS version, the installer may not 
support al l languages. If the language was not part of the original CIFS-ECS 
installation, you may be required to install the appropriate language pack by your 
Service Provider. 

Examples of languages that may be available for the installer or as language packs are:

◆ English (US) (default)

◆ Chinese (PRC)

◆ French (France)

◆ Korean (Korea)

◆ Japanese (Japan)

◆ German (Germany)

◆ Russian (Russia)

◆ Spanish (Latin America)

◆ Italian (Italy)

◆ Portuguese (Brazil)
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Adding user metadata tags

User metadata allows you to manage the way files are handled in the cloud based on 
policies created by your System Administrator. For example, your administrator may 
provide policies for how long to retain files in the cloud that you could then apply to 
specific folders or files based on your own retention policies. This option is accessed by 
right-clicking a file or folder and selecting CIFS-ECS > Add Tag. Refer to “Modifying 
CIFS-ECS metadata” on page 34 for details.

Recovering files

To recover files from a folder that has the Versioning setting enabled:

1. Right-click a file or a folder and select CIFS-ECS > Recover File to list the 
versions available. 

2. If you right-click on a parent folder, you can navigate to al l of the deleted 
subfolders to examine their contents. Also, you can use the Back button to 
navigate up the tree.

3. In the Recover Deleted File dialog, select the file or folder and click Recover. 

4. In the Confirmation prompt, select whether to replace a current file or restore the 
file with a new name.

Determining the properties of a file

Right-click on any file in Windows Explorer to display the Properties window. Select 
the CIFS-ECS tab to display CIFS-ECS-specific properties such as file status, upload 
date and time, and stub time.

Notes:

◆ A stub time or upload time that appears in red indicates the scheduled time for the 
activity.

◆ The status field shows “excluded” if the selected file has been excluded by an 
exclude rule.

◆ Files without reparse points may show scheduled time for upload or if it is 
excluded.

IMPORTANT

CIFS-ECS does not support files encrypted with the NTFS Encrypting File System 
(EFS) and ignores files that have been encrypted in this way. Also, any "System" file, 
identified by the SYSTEM file attribute, is excluded. You can modify this behavior in the 
Options > General tab. Refer to “General options” on page 43 for details.

Reporting

CIFS-ECS reporting enables you to create one or more different reports that can be 
generated periodically according to a schedule or on an ad hoc basis. The reports can 
also be emailed to one or more recipients. “Types of reports” on page 22 provides a list 
of reports and their contents.
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In the Report Detail dialog, you create a report definition which CIFS-ECS uses to 
generate the report. After the report is generated, CIFS-ECS saves it in a report file as 
an archived report in your report directory. 

CIFS-ECS maintains a relational database that stores the historical statistical data 
required to create the reports. This means that you can generate a report for a time 
interval in the past as long as the database is configured to go back to that point in the 
past. Typically, CIFS-ECS is configured to keep two-to-four weeks’ worth of historical 
data.

“Report options” on page 43 provides the global report settings for the relational 
database retention, the default report format, report directory location, and so on. The 
data directory path specified during “Step 1: Downloading and installing CIFS-ECS 
software” on page 7 determines the location of the relational database.

Viewing a list of available reports
To view a list of generated reports that have been archived in your report directory, 
select the Report toolbar button and then click Report Archive. The list appears in a 
Windows Explorer folder (for example, C:\ProgramData\CIFS-ECS Data\Reports\).

To view a list of report definitions that have not yet been processed as reports, select 
the Report toolbar button. The list appears in the Report dialog.

Viewing an individual report
To view an individual report:

◆ For an archived report, open the report file listed in the Windows Explorer folder.

◆ Create a report definition and run it using the Preview button in the Report dialog. 

Creating a report definition
When you create a report definition, you can run it immediately to generate the report, 
save the report definition, or schedule it to run unattended at a convenient time. 

Prerequisite: Before you begin, ensure that the global report settings are set properly 
in “Report options” on page 43.

To create a report definition:

1. Select the Report toolbar button.

2. Click New in the Report dialog.

3. In the Report Detail dialog, complete the fields as described in Table 8.

Table 8  Report Detail field descriptions  (page 1 of 2)

Field Description

Report Name Optional, specify a name for the report definition. Typically, you name the report 
definition if you intend to save it or schedule it to be run automatically. A report 
definition for an ad hoc report does not require a name unless you want to refer to it 
later as an archived report.
Do not use the following special characters in the report definition name:
/\:*?"<>|

These characters are il legal for file names and the report definition name is used as 
part of file name for the generated report.
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4. Optional, click Save to save the report definition. 

Save is enabled if you specified a name for the report definition.

5. Click Preview to run the report.

Types of reports

Table 9 lists the types of reports that you can generate. 

Template Select the report type:
 Overview
 Active File
 Change Log
 Internals
 Performance
“Types of reports” on page 22 provides detailed information about the report types.

Parameters For the selected template, click Parameters to change the sample interval used to 
create the report.

Data Range Start time Select the start time to begin the report processing. 
The start day is the day when you actually run the report definition by clicking the 
Preview button or the date specified in the schedule.

Data Range Duration Specify the duration of the historical statistical data to be used for the report. Values 
can be days, hours, and minutes (example: 3 Days 00:00).

Generating Schedule Click Schedule to set a generation schedule as described in “Setting the report 
generation schedule” on page 23. 

E-mail when data is ready Optional, for scheduled reports, select this checkbox to distribute the report to the 
specified recipients.

Email Address Specify one or more email addresses. Separate multiple email addresses by using any 
of these characters: a space, a comma, a semicolon, or a colon.

File Format Is the file format for the report email attachment (.pdf, .xls, .rtf or .mht) as specified 
in the Report Option tab (“Report options” on page 43). 

Table 8  Report Detail field descriptions  (page 2 of 2)

Field Description

Table 9  Report types  (page 1 of 2)

Report type Description

Overview This report shows general functionality. It contains:
 A graph of overal l network traffic to and from al l servers (Bytes/sec) and the total 

bytes sent/received.
 A graph of the upload, restore and stub frequency throughout the time period, 

including the totals of each operation.
 A graph of the number of active files throughout the time period.
 For each defined cloud drive:

- A graph of overall network traffic to and from the server.
- A graph of the size of the change log queue for this drive.
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Setting the report generation schedule

To run the report definition automatically, specify the schedule information in the 
Schedule dialog. For example, you can run a report once on a specific day at midnight 
or run a report at 4PM on the last Sunday of every month for three months.

1. Select the Enable Schedule checkbox.

2. Select the time to start processing the report in the Start at field.

3. In the Recurrence Pattern pane, choose a pattern, and set the values as necessary:

 Once.

 Daily, every weekday or every <number> of days.

 Weekly, every <number> of weeks on a selected day.

 Monthly, Day <number> of every month or a specific day (example: 2nd 
Monday) of every month.

4. In the Range of Recurrence pane, select:

 For Once: A start date.

 For al l other pattern selections: A range with start and end dates.

Active File This tabular report shows Active File Database statistics and other internal information:
 Active Files.
 Active File Cache size.
 Active File Cache Dirty size.
 Active File DB sessions.
 Access Map size.

Change Log This tabular report shows al l change log statistics. It contains one table for each defined 
cloud drive:
 Change Log Queue Length.
 Change Log Queue Input Rate (ops/sec).
 Change Log Queue Output Rate (ops/sec.)
 Change Log Threads.
 Change Log Queue Length High Water.
 Number of current Change Log work items.
 Change Log Overflow.

Internals This report shows the state of all internal queues:
 Async Worker Threads.
 Async Worker Queue Length.
 Async Worker Queue Rate (ops/sec).
 Fast Queue Threads.
 Fast Worker Queue Length.
 Fast Queue Rate (ops/sec).

Performance This tabular report shows the numbers used to create the first graph in the Overview 
Report:
 Bytes Sent.
 Bytes Received.

Table 9  Report types  (page 2 of 2)

Report type Description
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5. Click OK.

6. Return to the Report Detail dialog and complete any remaining settings.

7. Click Save to save the report definition.

Running an unscheduled report definition
If you previously created a report definition without a generation schedule and saved it, 
you can run the report as follows:

1. Select the Report toolbar button.

2. Select the report definition listed in the Report dialog.

3. Click Preview to run the report.

Modifying a report definition
To modify a report definition:

1. Select the Report toolbar button.

2. Select the report definition listed in the Report dialog.

3. Click Modify and change the report definition or its schedule as necessary.

4. Click Save to save the report definition or click Preview to run the report.

Deleting a report definition
To delete a report definition:

1. Select the Report toolbar button.

2. Select the report definition listed in the Report dialog.

3. Click Delete and OK.

Accessing the Report Option tab
You can access the Report Option tab by selecting CIFS-ECS Console > Home > 
Options or by selecting Option in the Report dialog. “Report options” on page 43 
provides the global report settings for the relational database retention, the default 
report format, report directory location, and so on.

Troubleshooting CIFS-ECS
If you are experiencing issues with installing CIFS-ECS or with transferring data to and 
from the cloud, use this section to resolve common problems experienced by 
CIFS-ECS users before contacting your Service Provider.

Check the status and performance of your cloud connection by opening the CIFS-ECS 
application at Start > All Programs > CIFS-ECS.

◆ You should see a green icon and status messages that detail the startup of 
CIFS-ECS when you started your computer, recent file transfers to the cloud, etc. 
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◆ If the ECS Host icon is red, it means that CIFS-ECS is not able to establish a 
connection to the cloud host. Select the entry by clicking on it. You will see an 
error code, time of disconnect and a reason in the pane to the right.

You can also double-click on the error message in the lower pane to get more details.

Table 10 on page 25 describes common CIFS-ECS issues and their possible resolution.

Table 10  CIFS-ECS issues and their resolution (page 1 of 2)

CIFS-ECS Issue Cause Possible Resolution

During an instal lation (after 
you click Install) or an 
uninstallation, you receive 
the message “This setup is 
unable to automatical ly 
close al l requested 
applications”. 

The Windows Restart 
Manager cannot stop 
Windows Explorer 
(explorer.exe).

The workaround is:
1. Before you click OK in response to the message, open the 

Windows Task Manager. (Use Ctrl + Alt + Delete or for a 
remote desktop connection, use Ctrl + Alt + End.)

2. In the Task Manager, stop the running Windows Explorer 
process (explorer.exe).

3. Click OK in response to the message.

4. Then, the instal lation or uninstallation proceeds and, upon 
completion, Windows Explorer is restarted.

Clicking the TEST button 
during server configuration 
generates an error message.

Incorrect server configuration 
settings

Check the cloud host settings (user ID, IP address, and shared 
secret) to make sure they are correct (see Table 3 on page 10).

Incorrect proxy server 
settings.

If your Service Provider required you to use a proxy server, 
verify the proxy server settings (refer to Table 4 on page 11 for a 
description of the settings).

You are using HTTPS and 
CIFS-ECS and the ECS host 
do not share a valid SSL 
certificate.

Refer to “Configuring SSL certificates” on page 32.

Red Icon No network connection. CIFS-ECS does not have a connection to the cloud. Check your 
network connectivity (is your browser working?).

Missing or incorrect 
CIFS-ECS configuration 
settings.

Check the cloud host settings (user ID, IP address, and shared 
secret) to make sure they are correct (see Table 3 on page 10). 
For example, check for an extra space after the shared secret.

The computer does not have 
the correct time. 

If your computer has the incorrect time, it will not be able to 
synchronize with the cloud host. Contact your Service Provider 
to resolve this issue.

CIFS-ECS status pane 
displays “error creating file 
in ECS server.”

There may be a temporary 
issue with the CIFS-ECS 
connection to the ECS host or 
with the ECS host itself.

CIFS-ECS wil l continue to attempt to upload the file on the 
ECS host. If it is unable to complete the upload, eventually a 
“File cannot be uploaded to cloud server. Upload retries are 
exhausted” message displays (refer to the fol lowing row in this 
table for details).

CIFS-ECS status pane 
displays “File cannot be 
uploaded to cloud server. 
Upload retries are 
exhausted.” Additional ly, 
“Failed Uploads:” appears in 
the Console View panel with 
a Retry button.

CIFS-ECS’s repeated 
attempts to upload files to the 
cloud failed.

This may be a temporary cloud host issue. Click the Retry 
button in the View panel. If CIFS-ECS again generates this 
error, contact your Service Provider to resolve this issue.
Click Copy List to place on the clipboard a plain text list of the 
files that failed to upload.
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Upgrading CIFS-ECS
By default, CIFS-ECS automatically checks for new updates every five days and 
displays a popup notification from the Console if a newer version exists. 

You can also check for newer versions of the application by selecting Check for 
Update from the drop-down menu that is accessed through the CIFS-ECS icon in the 
upper left corner of the CIFS-ECS Console. The Update Available window opens if a 
newer version of CIFS-ECS is available. You can click Upgrade to download the .exe 
file and begin the upgrade. If a newer version is not available, a message displays 
telling you that this version of CIFS-ECS is the current version. 

Note: Select the “Don’t notify me about this version” checkbox in the Update 
Available window if you do not want to upgrade to this version and do not want any 
further notifications about this version. You wil l receive a notification when a later 
version is available.

For information about the newer version of CIFS-ECS, consult the latest EMC 
CIFS-ECS Tool Release Notes which is available on the Support website, 
https://support.emc.com. 

You do not see files in your 
CIFS-ECS that were 
uploaded to the cloud via 
another CIFS-ECS, even 
after waiting an extended 
time period.

The CIFS-ECS folder has not 
refreshed.

Close the CIFS-ECS folder and reopen it. 

The default update time is set 
too high.

Check the advanced settings (refer to Table 6 on page 13). The 
Update Wait Time setting may need to be set to a lower time 
period (by default it is 1 day).

Files placed on your 
CIFS-ECS are not on your 
ECS server.

“Delay after file is closed 
before uploading to the cloud” 
setting is too high a value.

Check the advanced settings (refer to Table 6 on page 13). The 
Modify Wait Time setting may be set higher than you desire.

You clicked “F5” (refresh) 
but your CIFS-ECS view did 
not refresh.

The “F5” command refreshes 
files in folders on your local 
drive, but does not refresh the 
CIFS-ECS files stored in the 
cloud.

Close and reopen the CIFS-ECS folder to refresh the view.

Files sizes displayed in 
CIFS-ECS stay the same 
even for stub files.

CIFS-ECS displays the 
original size of the files, even 
after they are “stubbed.”

This is normal behavior for CIFS-ECS. You always see the 
original size of the file, if a “stub” replaced the file in the 
CIFS-ECS folder (refer to Table 2 on page 9).

Your CIFS-ECS Console is 
running, but you do not see 
your CIFS-ECS listed and 
none of the icons are active.

The CIFS-ECS service may 
have failed to start or is 
stopped.

Restart the CIFS-ECS  Service (Control Panel > Admin Tools 
> Services, right click CIFS-ECS  Service, and select 
Restart).

Table 10  CIFS-ECS issues and their resolution (page 2 of 2)

CIFS-ECS Issue Cause Possible Resolution

http://support.emc.com


Uninstalling CIFS-ECS 27

Getting Started with CIFS-ECS Tool

  Upgrading CIFS-ECS procedure

Use the following procedure to upgrade CIFS-ECS.

If you clicked Upgrade through the Update Available window, CIFS-ECS automatically 
starts the upgrade wizard (step 3 in this procedure). Start your upgrade with step 1 if 
you downloaded the CIFS-ECS upgrade executable file using a method other than 
through the “Check for Update” option. 

1. Download the CIFS-ECS executable file from the Support website 
https://support.emc.com and save it to a folder on your Windows computer.

2. Ensure that the CIFS-ECS console and the CIFS-ECS Activity Monitor are closed 
on the computer being upgraded and that al l open files in CIFS-ECS are closed.

3. Double-click the CIFS-ECS executable file to start the wizard.

Note: During an upgrade, the InstallShield screens display the term “Install” (not 
“upgrade”). This is expected behavior. 

4. Follow the prompts to complete the upgrade. 

5. The upgrade process checks to see if a reboot may be required. If it is, you can:

 Reboot Windows after the upgrade completes.

 Or, cancel the upgrade process and schedule the upgrade in a maintenance 
window.

6. After the upgrade completes, verify the CIFS-ECS version by clicking the 
CIFS-ECS icon to the left of the Home tab and selecting About from the menu.

Once the upgrade completes, your cloud access is restored with the same 
configuration settings as your previous CIFS-ECS version.

Uninstalling CIFS-ECS
Before uninstalling CIFS-ECS, you must ensure that any files sent to the cloud are 
properly saved so you can access them after the application is uninstalled. These files 
can be saved either locally or in the cloud if you have an alternate method for 
accessing them (from another computer running CIFS-ECS for example).

Saving files to the cloud before uninstalling CIFS-ECS

If you are uninstalling CIFS-ECS but stil l want to maintain your files in the cloud (and 
you have an alternative way to access them), you must ensure that al l files in the 
CIFS-ECS are updated to the cloud before uninstalling the application. 

1. Open your CIFS-ECS Console (Start > All Programs > CIFS-ECS).

2. From the CIFS-ECS Console, right-click the first drive in the Configuration window 
and select Delete. CIFS-ECS checks to make sure that al l files on that drive are 
written to the cloud before deleting the drive.

http://support.emc.com
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3. When deleting a cloud drive definition, you are given a choice of what to do with 
the local files that correspond to the cloud files. Select one of the following 
choices from the Confirm Cloud Drive Delete window:

 Delete the local files. Only the local files are deleted. The files in the cloud are 
not deleted but are inaccessible until you reconnect to the cloud drive.

 Leave local files (they wil l no longer be linked to the files on the cloud). The 
files that are not stub files are converted to normal files so they can be 
accessed without CIFS-ECS. 

If you select the option to leave local files, you given the option to Restore all 
file stubs. Restoring all file stubs from the cloud may take a considerable 
amount of time and require a large amount of disk space. If this option is not 
chosen, then all files that are not stubs are converted to normal files, but al l 
stub files are deleted.

4. Complete this process for each drive listed in the window.

5. Proceed to the “Uninstalling CIFS-ECS procedure” on page 28 to remove 
CIFS-ECS from your computer.

Uninstalling CIFS-ECS procedure

Once you have saved your files, complete the following steps to uninstall CIFS-ECS. 

Note: CIFS-ECS can be uninstalled through Control Panel > Programs > Uninstall a 
program, but the process may require a reboot of the system upon completion. The 
following procedure should complete the uninstall without requiring a reboot.

1. From your Windows Start > Computer menu, proceed to the CIFS-ECS 
installation directory. By default, CIFS-ECS is installed to the following location:

C:\Program Files\CIFS-ECS\

2. You should delete all cloud drives before uninstalling CIFS-ECS to ensure that 
local files are properly handled as outlined in “Saving files to the cloud before 
uninstalling CIFS-ECS” on page 27. 

Note: If you intend to reinstall CIFS-ECS in the future, refer to 
“Importing/Exporting a CIFS-ECS configuration” on page 43 for information about 
saving your existing CIFS-ECS configuration before deleting your cloud drive 
definitions.

3. Click Uninstall CIFS-ECS. The uninstall utility runs. CIFS-ECS may ask to stop 
and restart applications that CIFS-ECS must stop before completing the uninstall. 
If you do not al low CIFS-ECS to stop them, a reboot may be required.

4. If you attempt to uninstall CIFS-ECS with cloud drives stil l defined, a warning 
appears with the following choices:

 Click OK to force the uninstall. All local files are deleted including files that 
were awaiting upload to the cloud. Some data may be lost.

or
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 Click Cancel and return to the CIFS-ECS Console to remove all cloud drive 
definitions before reattempting the uninstall (see “Saving files to the cloud 
before uninstalling CIFS-ECS” on page 27).
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File recovery in the event of a computer failure
This section provides steps for recovering the files you placed in the cloud if your 
computer fails and you can no longer access your CIFS-ECS.

If your computer fails, you can easily recover your files by re-installing CIFS-ECS on 
another system using exactly the same credentials you used in the initial installation. 
Those credentials were provided by your Service Provider and include:

◆ User ID (UID) (For ECS, this is ECS Object User.)

◆ Secret access key

◆ Bucket

◆ Host names or IP address(es)

Proceed with the new CIFS-ECS installation starting with “Prerequisites” on page 6.

Once you complete the installation, you should have full access to the files in the 
cloud.

Enabling express recovery with USN Change Journal
After an outage, when the CIFS-ECS service resumes, an automatic and potential ly 
lengthy recovery of the cloud drive begins. In cases where the outage was short, 
CIFS-ECS can use the NTFS feature USN Change Journal to initiate an express 
recovery by identifying which files changed since the last successful checkpoint. The 
feature can save significant time.

If you did not enable the US Journal option when you configured your cloud 
connection, you can enable express recovery for a drive in the event of an outage: 

1. From the CIFS-ECS main page, select the CIFS-ECS drive and click Modify 
CIFS-ECS Drive to open the CIFS-ECS Drive Parameters window.

2. Click USN Journal.

3. Configure the journal or enter new parameters to create a journal for the first time. 
Note that the current Oldest USN Entry provides an approximation of how far 
back the journal goes. If the journal goes back farther than the outage, then the 
express recovery wil l occur. 

When CIFS-ECS performs a recovery for an outage, it first checks if an express 
recovery is possible (the USN Journal is enabled and the journal exceeds the outage 
time period). If an express recovery is possible, you are prompted to choose either an 
express or a full recovery. If an express recovery is not possible, CIFS-ECS performs a 
full recovery.

Configuring SSL certificates
In some situations, your Service Provider may require you to enable CIFS-ECS to use 
SSL (HTTPS) to communicate with your ECS server using a self-created 
(non-authoritative) certificate. During server configuration, you configured CIFS-ECS 
to communicate with the host using SSL by selecting HTTPS and entering the host 
name (not IP address) supplied by your Service Provider. 
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If the server details are entered correctly, you should be able to click Test and receive 
a “success” message which means that CIFS-ECS and the ECS server are 
communicating with each other. If not, verify your configuration settings and retry 
Test. 

If you receive a 12175 error - “A security error has occurred,” use Table 11 to determine 
the resolution associated with the specific error message.

As a temporary work-around to these error messages, see the Ignore HTTPS errors 
checkboxes in the Host dialog Advanced tab as described in Table 4 on page 11.

Installing the ECS certificate

If you receive a 12175 security error message that states: “The function is unfamiliar 
with the Certificate Authority that generated the server's certificate,” you need to 
install the ECS certificate on your CIFS-ECS host as follows:

1. After you click Test, CIFS-ECS displays a security error message that also 
provides the certificate details.

2. Verify that the host name is the same as the name supplied by your Service 
Provider and that you entered in the host/IP field during server configuration (refer 
to Table 3 on page 10). If not, confirm the correct name with your Service Provider 
before continuing. If necessary, delete the incorrect host name, enter the correct 
name in the Host/IP field, click Add, and then click Test. 

3. If a “success” dialog appears, you have completed this procedure and you should 
now have connectivity with the cloud (a green icon on the CIFS-ECS main page). 

Table 11   12175 security error messages

Error message Resolution

Certification revocation checking has been enabled, but the revocation 
check failed to verify whether a certificate has been revoked. The server 
used to check for revocation might be unreachable.

Re-try the Test, and if it fails, contact your Service 
Provider.

SSL certificate is invalid. Contact your Service Provider.

SSL certificate was revoked. Contact your Service Provider.

The function is unfamiliar with the Certificate Authority that generated 
the server's certificate.

Use the procedure outlined in “Instal ling the ECS 
certificate” on page 33.
Also, this error could indicate that the computer's 
time is not synchronized with the cloud server. 
It also may mean that the certificate is invalid.

SSL certificate common name (host name field) is incorrect. For 
example, if you entered www.microsoft.com and the common name on 
the certificate says www.msn.com.

Verify the host name you entered in the host/IP 
field.

SSL certificate date that was received from the server is bad. The 
certificate is expired.

Contact your Service Provider.

The application experienced an internal error loading the SSL libraries. Restart CIFS-ECS.
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4. If you receive the same error message again, click Install.

CIFS-ECS installs the SSL certificate on your local system and a “success” 
message displays. 

5. Click OK. You should now have a secure connection with the ECS host signified by 
a green icon on the CIFS-ECS main page.

Replacing the ECS certificate with a third-party certificate

In some cases your Service Provider may require a different third-party certificate 
instead of the ECS certificate. If the procedure in “Installing the ECS certificate” on 
page 33 fails, use the following procedure to install a third-party SSL certificate.

Note: This procedure requires administrative access to your computer.

1. As administrator, go to Start > Run and type MMC.

2. Go to File > Add Remove Snap-in.

3. Select the Certificates snap-in in the Available snap-ins pane and click Add.

4. Select Computer Account and click Next. 

5. Select Local Computer: (the computer this console is running on) and click 
Finish.

6. The Certificates (Local Computer) snap-in now appears in the right pane of the 
Add or Remove Snap-ins window. Click OK.

7. In the left pane, expand Certificates > Trusted Root Certification Authorities > 
Certificates. Right-click Certificates and select All Tasks > Import.

8. Follow the wizard to import the certificate.

Modifying CIFS-ECS metadata
Metadata tags provide a way for CIFS-ECS users to manage the way files are handled 
in the cloud. Your System Administrator creates policies that govern how files are 
stored (based on file type or naming convention, for example), and may provide you 
with metadata tags that you can then apply to specified files within CIFS-ECS.

Note: Ensure that you fully understand the policies applied to the files in your 
CIFS-ECS before modifying the Metadata. 

Use the procedures provided in this section to add, modify, or delete metadata tags 
based on the requirements or recommendations of your System Administrator. 

Adding a metadata tag to CIFS-ECS files
In this use case, your System Administrator provides you with a list of policies with 
associated metadata tags and values. You choose to apply one or more of these 
policies to al l (or a subset) of the files in your CIFS-ECS.
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Note: A CIFS-ECS user does not create policies or user metadata tags and values. 
These are provided by your System Administrator. A CIFS-ECS user applies the 
provided metadata tag and value to specific CIFS-ECS folders and files to ensure that 
the associated policy is applied to the files once they reach the cloud.

1. From the CIFS-ECS main page, select the CIFS-ECS drive and click Modify 
CIFS-ECS Drive to open the CIFS-ECS Drive Parameters window.

2. Click Metadata to open a User Metadata window that displays the user metadata 
currently applied to your CIFS-ECS. 

3. Click Add to open the User Metadata window where you assign path, tag, and 
value parameters.

4. Click the Browse icon to the right of the Path field and browse to the CIFS-ECS 
folder containing the files you intend to tag with metadata. If you do not select a 
path, then the root directory is assumed.

5. Check the Subdirectories box to have the metadata tags applied to al l 
subdirectories in the folder you designated in step 4.

6. Optionally, enter a Filename Pattern that al lows you to specify a subset of files to 
which to apply the metadata. For example "*" matches any number of characters 
(including none), and "?" matches exactly one character. These are just like normal 
Windows (DOS) wildcards.

7. Enter the user metadata Tag and Value provided by your System Administrator for 
the Policy you wish to apply to your files when they are stored in the cloud.

8. Click OK. The metadata definition now appears in the User Metadata window.

9. Click Close. The CIFS-ECS Drive Parameters re-appears and the Tag names of al l 
user metadata policies currently applied to this CIFS-ECS now appear to the right 
of the Metadata button.

10. Repeat this procedure for each CIFS-ECS that requires user metadata. This 
function is also available through the Explorer context menu.

Editing metadata tags
Edit metadata tags as follows:

1. From the CIFS-ECS main page, select the CIFS-ECS drive and click Modify 
CIFS-ECS Drive to open the CIFS-ECS Drive Parameters window.

2. Click Metadata to open a window that displays the user metadata currently 
applied to your CIFS-ECS. 

3. Select the metadata line that you intend to edit, then click Edit to open the editing 
window.

4. Edit the Path, Filename Patterns, Tag, or Value as appropriate and click OK. The 
edited metadata information appears in the User Metadata window. 

5. Click Close if the edited information is correct. Then, click OK at the CIFS-ECS 
Drive Parameters window to accept the changes.
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Deleting metadata tags
Delete metadata tags as follows:

1. From the CIFS-ECS main page, select the CIFS-ECS drive and click Modify 
CIFS-ECS Drive to open the CIFS-ECS Drive Parameters window.

2. Click Metadata to open a User Metadata window that displays the user metadata 
currently applied to your CIFS-ECS. 

3. Select the metadata line that you intend to delete, then click Delete. The metadata 
is removed from the list for this CIFS-ECS.

4. Click Close. The metadata tag name for the policy you removed no longer appears 
in the list to the right of the Metadata button.

5. Click OK to accept the changes or click Cancel to revert to the old metadata 
settings.

Configuring multiple site synchronization
Multiple site synchronization allows two or more CIFS-ECS servers pointing to the 
same cloud server to immediately synchronize their copies of files or folders when data 
is changed, or the file or folder is deleted.

The advantages are:

◆ This reduces the time that the CIFS-ECS servers are out of synchronization.

◆ If a file on client A is updated, when that same file is referenced on client B, the file 
wil l already be updated.

◆ An administrator does not have to manually reduce the value of "Update Wait 
Time" for a file or folder in order to access the updated file or folder.

Prerequisite: You have two or more CIFS-ECS servers configured to the same ECS 
cloud server (ECS bucket).

To configure multiple site synchronization, for each CIFS-ECS server or host, you need 
to inform it of its peer server and test the connectivity. Use this procedure:

1. For each CIFS-ECS server or host, click Manage Server Peers on the console 
toolbar. 

2. In the Server Peer List dialog, click Add.

3. Type the fully-qualified server name of the other CIFS-ECS server or its IP 
address.

4. Optional, type a description.

5. If the other server resides in a different domain, specify the login credentials for 
the other server.

6. Click Test to verify that the peer connectivity is successful.

7. Click OK.

8. Repeat Steps 1-7 for each server. For example, if there are two servers, you need to 
configure both servers to point to each other. For three servers, you need to 
configure all three to point to the other two servers.
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9. Verify the configuration:

a. In the Server Peer List dialog, select each server in the list, the Folder list 
should display the common list of cloud drives. If the Folder list is empty, there 
are no cloud drives pointing to the same files between the two servers. It might 
be true that same files are not yet synchronized between the two servers.

b. Make an update to a test file to confirm the configuration and to populate the 
Folder list.

At this point, if you make any updates to files or folders in the local system, 
CIFS-ECS uploads those updates to the cloud and the updates are also sent to 
al l configured peer servers. The peer servers wil l immediately do the same 
update. 

Monitoring the status of multiple site synchronization

The Server Peer List dialog, accessed by selecting the Manage Server Peers toolbar 
button, provides some status. Make sure you have a server selected at the top of the 
list. The status information is:

◆ Last Sent

◆ Last Received

◆ Queue Size

◆ Last Error

In addition, Performance Monitor provides more status information. The set of 
counters under "CIFS-ECS Server Peer" show more information about how often data 
is being sent to the other peer, how many threads are available for servicing, and so on.

To open the Performance Monitor from the CIFS-ECS Console, select the CIFS-ECS 
icon next to the Home tab and select Performance Monitor. The utility opens in a 
separate window. “Monitoring CIFS-ECS performance” on page 18 provides 
information about the Performance Monitor.

Specifying files to exclude from the ECS cloud
CIFS-ECS uploads everything in the source directories by default, but you can use the 
Excludes list to narrow the scope of the files that get stored on ECS by explicitly 
defining certain file types, file folders, and file paths to exclude from the upload 
operation. 

In the Excludes dialog, 

1. In the File Pattern field, type one or more filename patterns that you want 
CIFS-ECS to ignore wherever it encounters them. Separate patterns with a 
semicolon. Use “*” to represent any sequence of characters and “?” to represent 
any single character. For example:

*.tmp;*.temp;abc*

This string ignores all files that end with .tmp, .temp, or begin with abc.
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2. In the Folder Pattern field, type one or more folder name patterns that you want 
CIFS-ECS to ignore wherever it encounters them. Separate patterns with a 
semicolon. Use “*” to represent any sequence of characters and “?” to represent 
any single character. For example:

xyz*;folder??

3. To add a specific file to the ignore list, click Add > Add File. Navigate to the desired 
file and click OK. You can add multiple files in this manner. The file appears in the 
Exclude file or folder list, from where you can edit or delete it. 

4. To add a specific folder to the ignore list, click Add > Add Folder. Navigate to the 
desired folder and click OK. You can add multiple folders in this manner. The folder 
appears in the Exclude file or folder list, from where you can edit or delete it. 

Advanced options
CIFS-ECS provides a number of advanced options that are not required for a typical 
installation but may be required in enterprise-level configurations or where unique 
configuration challenges require more than the default CIFS-ECS configuration. 

The Options window is accessed from CIFS-ECS Console > Home > Options. The 
following sections provide details for each option tab.

Log options

Log options allow you to control how log messages for events that occur in CIFS-ECS 
are displayed, saved, and distributed. CIFS-ECS distributes status (info, warning, 
severe, and connection) messages both locally (through the CIFS-ECS console and 
Event Manager) and remotely (through SNMP and email). 

Table 12  Log options 

Log option Description

Severe CIFS-ECS is not functioning correctly. 

Warning Indicates an error that may affect data that CIFS-ECS is managing, such as a 
REST command to ECS is failing.

Info A non-error condition that the user may be interested in, such as a successful 
upload.

Connection Provides all log messages that pertain to ECS connectivity.
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Table 13 provides descriptions of the option fields.

Table 13  Log fields  

Log Field Description

Max Log Messages Enter the maximum number of log messages (default=1000) you want 
CIFS-ECS to display in the message pane of the CIFS-ECS Console. As the 
number of messages exceeds this amount, the oldest messages are deleted. 

Event Viewer By default, CIFS-ECS severe and warning messages are sent to the Windows 
Event Viewer on your local system. You can access CIFS-ECS messages in 
Event Viewer through Start > Al l Programs > Administrative Tools > Event 
Viewer > Windows Logs.

Main Window This setting (also available through the Status tab on the CIFS-ECS Console) 
al lows you to set which messages display in the message pane of the CIFS-ECS 
Console. By default, the Console is set to display severe and warning messages. 
You can change the settings either here or from the Status tab and your 
changes appear in both locations.

SNMP Select the messages on which you wish to set SNMP traps. You must have 
configured SNMP on this system before instal ling CIFS-ECS. During 
installation, CIFS-ECS checks for SNMP and instal ls the appropriate hooks to 
the SNMP service.

Email Select the status messages you wish to send via email.

Notification Area By default, CIFS-ECS severe and warning messages appear in a notification 
area associated with the CIFS-ECS icon on your Windows taskbar. Use the 
checkboxes to select which messages (if any) you want displayed in the 
notification area.

Email Recipient(s) Enter the email address where the log messages should be sent. Email setup 
requires additional configuration on the Email tab to designate the sender of the 
email and the SMTP mail server.

Test Use the Test button to determine if your email configuration is working 
correctly. You should see a “Test message sent successful ly” message as well 
as receive a test message at the specified email address. If the test fails, verify 
that the email settings you used in the Email option tab are correct.

Log Uploads When this option is enabled, CIFS-ECS displays an informational message in the 
Console and logs each file upload based on your log settings. Disable this option 
if you do not need to see or log every file upload. By default, the log file holds 
1000 messages.

Log Restores When this option is enabled, CIFS-ECS displays an informational message in the 
Console and logs each file restore based on your log settings. This log tells you 
what process caused the restore, the process ID, and the user associated with 
that process. Enabling this option gives you a powerful tool for troubleshooting 
issues such as when it appears that files are being restored by CIFS-ECS for no 
reason.
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Email options

Email options allow you to configure the email settings used by CIFS-ECS to email log 
files (see “Log options” on page 38). Table 14 provides descriptions of the Email option 
fields.

Processes option

CIFS-ECS automatically excludes some processes from accessing the files stored in 
CIFS-ECS folders (Windows Indexing Service and Windows Search, for example). 
Although highly unlikely, you may encounter an application that must be excluded 
from accessing your CIFS-ECS folders. The Processes option allows you to manually 
add (or remove) processes that need to be excluded from CIFS-ECS.

Note: Windows Indexing Service is excluded from CIFS-ECS because the process it 
uses for indexing files causes CIFS-ECS to recall files from the cloud and then stub 
them repeatedly each time the indexer runs.

Table 14  Email options 

Email Field Description

From Enter a valid email address (in the format any_user@abc.com). This is the 
address that appears in the “From” field on the log message email. 

Reply To Enter a valid email address for replies from email.

SMTP Server Enter the address of your SMTP mail server.

Require Authentication Provide mail server credentials to al low the administrator to receive CIFS-ECS 
log messages without opening the application.

Encryption If encryption is required, choose either SSL or TLS.

Log File Enable this field for troubleshooting only.
Enter a location (c:\smtp.txt for example) to write a log to that shows the 
status of each email message that CIFS-ECS attempts to send. If this is left 
blank, no email messages are logged.
Once the emails are working correctly, change this field to blank. Otherwise, 
the log continues to grow and all of the disk space will be consumed.

SMTP Port By default, CIFS-ECS uses port 25 as its SMTP port.

Timeout By default, CIFS-ECS wil l attempt to connect to the SMTP server for 20 
seconds before timing out.

Max Retries The number of times CIFS-ECS attempts to connect to the SMTP server (by 
default 3). If CIFS-ECS fails to connect after the number of Max Retries is 
reached, it stops trying and logs the issue.

Retry Interval The interval between each attempt to contact the SMTP server. By default, this 
is set to 5 minutes.

Msg Rate Limit The number of messages per minute CIFS-ECS is al lowed to send. 
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Table 15 provides descriptions of the Processes options fields.

The Add button displays the Add Process dialog.

Note: To select system threads for exclusion, select <SYSTEM> from the Add 
Process dialog and click OK.

You can exclude a process and then specify which specific CIFS-ECS functions to 
suppress with the process. Check the Enable checkbox and then select the desired 
functions, as described in Table 16 on page 41. If no functions are checked, then the 
process is excluded completely. If one or more functions are checked, then CIFS-ECS 
manages file access for that process normally except for the specific functions 
checked.  

Web Server Example
If a web server process opens a directory, then a very lengthy CIFS-ECS 
synchronization process may occur resulting in very slow web page performance. 
Therefore, you can exclude the web server process. Check Enable and check 
Synchronize Folder, Synchronize File, and File Not Found to prevent CIFS-ECS 
from responding to these web server activities. You leave File Restore unchecked 
because you want to restore any file stub that the web server process accesses.

In this scenario, CIFS-ECS would not detect updates to ECS files by another 
CIFS-ECS client, unless another process also accessed those files.

Windows Explorer Example
Some versions of Explorer as well as some anti-virus software wil l cause Explorer to 
restore a file if it is selected in Explorer or if it is right-clicked in Explorer. To avoid this, 
you can exclude explorer.exe and select the File Restore option. 

Table 15  Processes options   

Processes Fields Description

Image Paths to Exclude The image paths to exclude are Added/Removed here. Click Add to see a list of 
image paths to select for exclusion or to browse to a specified image. 

Currently Excluded 
Processes

This pane displays the currently excluded processes. 

Process Exclude 
Auto-Configuration

The auto-configuration option checks to see if Windows Indexing Service is 
active and if it finds it, adds it to the exclude list. 

Table 16  Exclude options on CIFS-ECS activities if triggered by a process  

Activity Description

Synchronize Folder Do not allow CIFS-ECS to check the cloud to see if a folder has been opened.

Synchronize File Do not allow CIFS-ECS to check the cloud to see if a specific file has been updated 
before opening it.

File Not Found If opening a file results in a local “File Not Found” message, do not al low CIFS-ECS 
to check the cloud to see if that file exists.

File Restore Do not allow CIFS-ECS to restore a stub into a real file. 
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This prevents any Explorer accesses from restoring the file. Be aware this may have 
side effects. For instance, if there is a ZIP file that has been stubbed and the user 
accesses that file using Explorer, the access fails since Explorer manages ZIP files and 
it wil l not be able to open the file.

Performance options

Performance options allow you to set the number of threads that CIFS-ECS uses for 
its various processes.

Note: Increasing the number of threads from the default values causes increased CPU 
load and overhead that can adversely impact the performance of other applications 
running on your system.

Table 17 on page 42 provides descriptions of the Performance options.

Table 17  Performance options 

Option Description

Upload Threads The number of simultaneous uploads that can be performed.

Restore Threads The number of simultaneous file restores that can be performed.

Multipart Threads (restore) For each file restore, the number of simultaneous download threads that are run 
(with a maximum of 4). This al lows multiple portions of the file to be 
downloading simultaneously. 

Multipart Threads (upload) For each file upload, the number of simultaneous upload threads that are run. 
This is similar to “HTTP Threads (restore)”.

Maximum Write Request The maximum size of each upload request. If this setting is 0 or empty, there is 
no maximum. In that case, the write request is the same size as the buffer size 
(below). A smaller value in this field can help when the available bandwidth is 
not large and with timeout errors. Using a smaller value also makes the 
Performance Monitor “Bytes Sent” counter appear more accurate (as a steady 
rate instead of periodic pulses of activity).
If you have a fast connection and want to maximize the transfer rate, this should 
be set to 0.

Upload/Download Buffer 
Size

The size of individual upload/download requests. A larger value general ly 
provides for a faster transfer at the expense of using up more internal resources.

Multipart Transfers This allows you to configure when multipart transfers are used. For large files, 
CIFS-ECS will split the file into multiple segments and transfer each segment in 
its own thread. The fields used to configure multipart transfers are:
 Minimum Threshold: If a file is smaller than this threshold, it is transferred 

in one thread. If the file is larger than this size, it is split into multiple parts 
and transferred in separate threads.

 Maximum Part Size: If the file is larger than Minimum Threshold, the file is 
split into multiple parts no larger than this value.
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General options

Table 18 provides descriptions of the General options.

Report options

You can access the Report Option tab by selecting CIFS-ECS Console > Home > 
Options or by selecting Option in the Report dialog.

CIFS-ECS provides several types of reports. These report options are global settings 
that apply to al l reports. Table 19 provides descriptions of the Report options.

Importing/Exporting a CIFS-ECS configuration

If you are installing CIFS-ECS on multiple systems using similar configuration 
parameters, you can configure the first system and export the configuration 
information. The configuration can then be imported into the other systems.

Table 18  General options 

Option Description

Transfer Status 
Always On Top

Selecting this checkbox makes the Transfer Status window stay on top of all other 
windows. This function takes effect as soon as the checkbox is selected.

Do not save file 
security descriptors 
in cloud server

If set, file security descriptors are not saved with the file on ECS. Use this setting in cases 
where the default security descriptors for files (those inherited by the parent directory) are 
fine. If preserving security descriptors is important, for instance in multi-user environments, 
this should be unchecked. This is a global setting.

Do not exclude files 
with the SYSTEM 
file attribute

Normally, CIFS-ECS will not manage any file with the SYSTEM file attribute. It will not be 
uploaded or stubbed out. If this is set, SYSTEM files will be managed like a normal file. This 
is a global option.

Table 19  Report options 

Option Description

Enable Sampling 
and Reporting

Enables data sampling for sample intervals and reporting. Selected by default. It is required 
for reporting.

Retention The number of days that the relational database stores the historical statistical data 
required to create the reports. Specify an integer up to 90 or accept the default of 14 days.
Typical ly, CIFS-ECS is configured to keep two-to-four weeks’ worth of historical data.
You can generate a report for a time interval in the past as long as the database is 
configured to go back to that point in the past. 

Report Directory The report directory where generated reports are stored. Browse to your location or accept 
the default. The default location is: 
C:\ProgramData\CIFS-ECS Data\Reports\

Default File Format The file format for al l reports. Choices are .xls, .pdf, .rtf, and .mht. The default is Adobe 
PDF Files (*.pdf).

Maximum Number 
of Report Files

The maximum number of report files you can save, including archived reports. Specify an 
integer from 0 to 500. The default is 10.
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Exporting a CIFS-ECS configuration
To export a CIFS-ECS configuration:

1. From the CIFS-ECS Console, select the CIFS-ECS icon next to the Home tab to 
display the drop-down menu and click Export Configuration. 

2. Browse to the location where you intend to save the file and enter a name for the 
exported configuration. 

Optionally, enter a password to protect access to the configuration. 

3. Click OK to export and save the configuration.

Importing a CIFS-ECS configuration
To import a CIFS-ECS configuration:

1. Ensure that CIFS-ECS is installed and running on the system to be configured.

2. Save the exported CIFS-ECS configuration file to the new system. 

3. From the CIFS-ECS Console, select the CIFS-ECS icon next to the Home tab to 
display the drop-down menu and click Import Configuration. 

4. Browse to the location where you saved the file, select the file, and click Open. 

5. Enter the same password you used to protect access to the configuration if you 
used one when you exported the file. 

6. Click OK to import the configuration.

Over a period of several seconds, CIFS-ECS imports and applies the new 
configuration. The Drive descriptions appear and green icons display, signifying a 
connection based on the new configuration.

Cloud Explorer
Cloud Explorer is a utility accessed through the CIFS-ECS toolbar or by right-clicking 
on the CIFS-ECS icon in your taskbar. It al lows you to manage your files and 
directories in the cloud similar to the way you manage local files on your computer 
using Windows Explorer.

IMPORTANT

The changes you make through Cloud Explorer to files in the cloud wil l eventually 
appear on your local CIFS-ECS, but depending on your CIFS-ECS advanced settings 
(see Table 6 on page 13), it may take an extended period of time for you to see the 
changes on your local system. Be sure to verify that no one else is accessing these files 
while you are modifying them through Cloud Explorer to prevent conflict.

1. Click the Cloud Explorer icon in the CIFS-ECS toolbar to open a window displaying 
all of your cloud directories and files. 

2. Double-click on a directory in the left pane to display the contents in the right 
pane. 
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3. Right-click on a file or directory to display a list of options that al low you to view 
details about the file, upload to a selected location, view and edit access rights and 
metadata, or to download, delete, or rename the file. 

Uploads are supported by using either the toolbar button (the white sheet of paper 
with a green up arrow), or by dragging files and directories from Windows Explorer to 
Cloud Explorer.

Downloads are supported by either right-clicking on a file and choosing Download, or 
by dragging files and directories from Cloud Explorer to Windows Explorer.

Note: You can only open or delete directories to which you have authorized access. 
Attempting to open or delete a directory to which you do not have access generates an 
error message that states: “The request could not be completed due to insufficient 
access privileges.”

Verifying CIFS-ECS support for bucket retention
This feature requires administrative privileges.

If you selected Virtustream as a server type, the Retention feature is not supported.

CIFS-ECS supports buckets that are configured to put al l data into retention. This 
support is automatic and does not require any specific configuration. 

For bucket-retention support, ensure the following: 

1. For ECS, open the ECS UI to verify that the bucket exists and the retention time 
period is set for the bucket. If the bucket does not exist or a retention time period is 
not set, use the ECS UI to create it and set the retention time period.

2. For CIFS-ECS, verify that a cloud drive is configured for the specific bucket. If the 
cloud drive is not configured, refer to “Step 2: Configuring the CIFS-ECS folder” 
on page 9 for complete information about configuring a cloud connection.

Behavior for a bucket with a retention setting is different than the behavior for a bucket 
without retention. When using bucket-level retention, the behavior is: 

◆ As soon as a file has been uploaded to ECS, it wil l become read-only. The Read 
Only attribute is set and cannot be changed.

◆ Any attempt to modify the file or remove the Read Only attribute results in Access 
Denied error.

◆ Once the retention time period has elapsed, the file wil l become writeable again, 
contingent on the following:

 CIFS-ECS determines that the object is no longer in retention by comparing the 
object’s creation time and the retention period. To do so, the clock in ECS must 
be synchronized with the clock in the Windows server. If the times are not 
synchronized, the CIFS-ECS calculation wil l be inaccurate.
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 Update Wait Time can have an effect on when CIFS-ECS wil l check if an object 
is out of retention. For instance, if Update Wait Time is 1 week, then CIFS-ECS 
may not al low changes to the file up to 1 week after the object becomes 
writable in ECS.

Translating ECS/Windows permissions
This feature requires administrative privileges.

If you selected Virtustream as a server type, the translating ECS/Windows permissions 
feature is not supported.

During installation when creating a CIFS-ECS cloud drive, you can enable the 
Translate ECS/Windows Permissions option. If enabled, this option translates the 
Windows permissions into an equivalent ECS/S3 access control list (ACL) when 
uploading the file. To use this feature, CIFS-ECS needs the complete list of Windows 
users and their corresponding ECS/S3 account name. This is maintained using the 
CIFS-ECS console.

When CIFS-ECS uploads a file, it creates an ACL that attempts to match the 
corresponding ACL in the file security descriptor. CIFS-ECS reads through the list of 
ACE entries in the Windows security descriptor. Any DENY entries and write-only files 
are ignored. 

For al l Allow entries, CIFS-ECS looks up the user in the CIFS-ECS user database:

◆ If a user is found, CIFS-ECS creates an ACL entry for that user with the same 
capability (read/write/full control).

◆ If the user does not exist in the database, it is ignored.

◆ Top level group entries are expanded to their list of users.

◆ Audit entries, owner and primary group are ignored.

Note: When uploading files, the ACL is specified as an HTTP header entry. This 
creates an upper limit for the number of object user IDs that can be specified for a 
single file. For example, if you add "Domain Users" to the User Database and a file 
specifies "Domain Users" for READ access, the HTTP header size limit wil l likely be 
exceeded if you have hundreds or thousands of domain users.

Enabling ECS/Windows permission support

While configuring a cloud connection, be sure to test the connection between the 
CIFS-ECS and the ECS cloud as described in “Step 3: Testing your configuration” on 
page 15. In some cases, a separate HTTPS certificate must be installed. Consult 
“Troubleshooting CIFS-ECS” on page 24 about troubleshooting and SSL certificates.
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Enable the Translate ECS/Windows Permissions option on the Settings tab of the 
Create Cloud Drive wizard. By default, this feature is disabled since it impacts 
performance and requires that the User Database be maintained. Refer to step 11 on 
page 11 in “Step 2: Configuring the CIFS-ECS folder” for information about the 
Translate ECS/Windows Permissions option while configuring a cloud connection.

Maintaining the user database

The local database is maintained by the CIFS-ECS console and CLI.

To perform maintenance tasks, you must have ECS SYSTEM_ADMIN credentials for 
the ECS server.

To view the User Database list, next to the Home menu, select CIFS-ECS icon > 
Windows/ECS Accounts. 

In the Windows/ECS Account Maintenance dialog, you can see the current User 
Database list, as well as add and remove entries individually or in bulk.

In the User Database list, the Windows Account name matches the ECS S3 user name. 
In some cases, the ECS S3 user name includes an optional prefix (for example 
“win.frank”). 

If you want to create a Windows user name that is different from the ECS user name, 
you must use the Manual Add option (“Manually adding users” on page 47).

Adding or creating users
The first time you use the Add option, you are prompted for SYSTEM_ADMIN 
credentials for the ECS server. The CIFS-ECS uses the credentials to create users in 
ECS that correspond with the Windows accounts. 

To add or create users in the User Database list:

1. In the Windows/ECS Account Maintenance dialog, click Add.

2. If prompted, provide your ECS SYSTEM_ADMIN user name and password.

a. Click Test to verify the connection between the CIFS-ECS host and the ECS 
cloud. In some cases, a separate HTTPS certificate needs to be installed on the 
local server. Consult the “Troubleshooting CIFS-ECS” on page 24 about 
troubleshooting and SSL certificates.

b. Click OK.

3. In the form, select a Windows user or group to query the Windows Active Directory. 

If you selected a group, it is the same as selecting all of the users in that group. For 
each user, CIFS-ECS checks if the user exists in the User Database. If so, 
CIFS-ECS verifies that the user is also an ECS S3 user.

If the user is not in the User Database, CIFS-ECS creates the ECS S3 object user 
and creates an entry in the database. 

Manually adding users
To add or to create a Windows user name that is different from the ECS user name:

1. In the Windows/ECS Account Maintenance dialog, click Manual Add.
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2. In the form, provide the Windows account, ECS S3 object user ID and secret. 

The manual Add option wil l not create the S3 object user. The S3 object user ID 
must already exist.

Deleting users
To delete users from the User Database list and the corresponding ECS S3 object 
users:

1. In the Windows/ECS Account Maintenance dialog, select one or more entries from 
the User Database list.

2. Click Delete.

File system logging
Table 7 on page 14 describes the Logging tab where you configure file system logging 
for the cloud drive. This section provides additional information about file system 
logging. 

CIFS-ECS logs the following operations. Table 20 lists al l of the operations that can be 
logged and which checkbox to select. 

Table 20   Logged operations  (page 1 of 2)

Operation Select the checkbox Description

FileCreate Create File is created.

FolderCreate Create Folder is created.

FileDelete Delete and Rename File is deleted.

FolderDelete Delete and Rename Folder is deleted.

FileStubDelete Delete and Rename File stub is deleted.

FileUpdate Data update File data is updated.

FileAttribUpdate Attribute Update File attribute is updated.

FilePermUpdate Permission Update File permissions are updated.

FolderRename Delete and Rename Folder is renamed.

FileRename Delete and Rename File is renamed.

StubRename Delete and Rename File stub is renamed.

SectionWrite Data update File is updated using a section 
write.

Upload CIFS-ECS Operations CIFS-ECS uploads the file to ECS.

Restore CIFS-ECS Operations CIFS-ECS restores a file stub from 
ECS.

Stub CIFS-ECS Operations CIFS-ECS stubs a file.

FolderSync Folder Synchronize CIFS-ECS synchronizes a folder.

FileDeleteGD CIFS-ECS Operations CIFS-ECS deletes a file because it 
has been deleted on ECS.
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Log file naming convention

The log files are text encoded in UTF-8. They are formatted as comma-separated value 
(CSV) and can be read using Excel.

The log file is not localized.

The file name is formatted as:

Log_003_2015_06_02_13-43-56-471.csv

Where:

003 – Number assigned to the cloud drive definition.

2015_06_02_13-43-56-471 – Date and time in UTC. The last three digits are 
mil liseconds.

Log file contents

The file is opened in “shared read” mode so it can be read while it is being written to. 
The first row of the file contains the cache path of the cloud drive. The second row 
contains the headings for the columns and subsequent rows are data.

FolderDeleteGD CIFS-ECS Operations CIFS-ECS deletes a folder 
because it has been deleted on 
ECS.

FileStubAttribUpdate Attribute Update The attributes on a file stub are 
updated.

FileStubPermUpdate Permission Update The permissions on a file stub are 
updated.

Table 20   Logged operations  (page 2 of 2)

Operation Select the checkbox Description

Table 21  Log file column information  (page 1 of 2)

Column Description

Time Time of the operation in UTC.

Operation Operation that occurred. See Table 20 on page 48. This will be “FileCreate”, 
“FolderCreate”, etc.

State State of the file at the time of the operation. Values can be: NotUploaded, 
Uploaded, UploadedModified, and Stubbed.

File The file path without the cache path root.

RenameTo If rename, this is the target path.

First Open 1 if a process opens a file that is not opened by any other process. It is 0 if it 
is a subsequent open.

Directory 0 if file. 1 if directory.

Process Process path that caused the operation.

User User account that the process was running under.
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File attributes
Possible file attributes and their hex values are:

#define FILE_ATTRIBUTE_READONLY             0x00000001  
#define FILE_ATTRIBUTE_HIDDEN               0x00000002  
#define FILE_ATTRIBUTE_SYSTEM               0x00000004  
#define FILE_ATTRIBUTE_DIRECTORY            0x00000010  
#define FILE_ATTRIBUTE_ARCHIVE              0x00000020  
#define FILE_ATTRIBUTE_DEVICE               0x00000040  
#define FILE_ATTRIBUTE_NORMAL               0x00000080  
#define FILE_ATTRIBUTE_TEMPORARY            0x00000100  
#define FILE_ATTRIBUTE_SPARSE_FILE          0x00000200  
#define FILE_ATTRIBUTE_REPARSE_POINT        0x00000400  
#define FILE_ATTRIBUTE_COMPRESSED           0x00000800  
#define FILE_ATTRIBUTE_OFFLINE              0x00001000  
#define FILE_ATTRIBUTE_NOT_CONTENT_INDEXED  0x00002000  
#define FILE_ATTRIBUTE_ENCRYPTED            0x00004000  
#define FILE_ATTRIBUTE_INTEGRITY_STREAM     0x00008000  
#define FILE_ATTRIBUTE_VIRTUAL              0x00010000  
#define FILE_ATTRIBUTE_NO_SCRUB_DATA        0x00020000  
#define FILE_ATTRIBUTE_EA                   0x00040000  

File dispositions
Possible file dispositions and their hex values are:

#define FILE_SUPERSEDE                  0x00000000
#define FILE_OPEN                       0x00000001
#define FILE_CREATE                     0x00000002
#define FILE_OPEN_IF                    0x00000003
#define FILE_OVERWRITE                  0x00000004
#define FILE_OVERWRITE_IF               0x00000005

Duration Duration in seconds that the operation took. This field is only available for 
the fol lowing operations: Upload, Restore, Stub, FolderSync, FileDeleteGD 
and FolderDeleteGD.

File Size Size of file, if available.

Attributes File attributes. This is displayed as a hex value. Possible file attributes are 
listed in “File attributes” on page 50. Multiple attributes are OR’ed 
together.

Disposition This shows how the file was opened. Possible values are listed in “File 
dispositions” on page 50.

Status File open status. This shows what happened as the file was opened. 
Possible status values are listed in “Open status” on page 51.

Access Shows what access was requested in the file open. It contains values such 
as: FILE_READ_ATTRIBUTES, FILE_READ_DATA, GENERIC_READ, 
FILE_LIST_DIRECTORY, etc.

Exclude The exclude mask. This indicates if the user has instructed specific 
operations to be excluded using the Process tab of the Options dialog. 
Multiple values are OR’ed together. Values for this are:
0x4 – Not Found
0x8 – Restore
0x10 – Sync file
0x20 – Sync path

Table 21  Log file column information  (page 2 of 2)
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Open status
Possible open status values and their hex values are:

#define FILE_SUPERSEDED                 0x00000000
#define FILE_OPENED                     0x00000001
#define FILE_CREATED                    0x00000002
#define FILE_OVERWRITTEN                0x00000003
#define FILE_EXISTS                     0x00000004
#define FILE_DOES_NOT_EXIST             0x00000005
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CHAPTER 3
Gateway Support

The CIFS-ECS Tool establishes an enterprise “gateway” server designed to support 
multiple client user access to the ECS cloud. In this scenario, CIFS-ECS is hosted on a 
Windows server and shared to individual users via CIFS (each user maps a network 
drive). The use case described in this chapter assumes the use of a clustered Windows 
environment for failover support.

This chapter describes the following topics:

◆ About CIFS-ECS File Server support ................................................................... 54
◆ CIFS-ECS cluster support ................................................................................... 54
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About CIFS-ECS File Server support
The CIFS-ECS File Server use case is designed to support many users accessing the 
ECS cloud without the need for individual CIFS-ECS clients running on each local 
system. The system provides data availability by utilizing the standard CIFS-ECS to 
ECS cloud interface, and ease of access by allowing users to map a network drive 
through the CIFS-ECS to the ECS cloud. Optionally, the system can provide fault 
tolerance by placing CIFS-ECS in a Windows cluster environment.

For fault tolerance, CIFS-ECS supports installation on an active-passive Windows 
Failover Cluster. The CIFS-ECS resources are shared across the cluster so that the 
new primary CIFS-ECS always picks up the current configuration in the event of a 
failover. 

This chapter provides guidelines for configuring CIFS-ECS in a clustered environment. 

CIFS-ECS cluster support
CIFS-ECS is supported in a Windows clustered (active-passive) environment. Follow 
the guidelines in this section to configure CIFS-ECS to work in a cluster.

Note: The clustered environment must be up and running before installing CIFS-ECS.

During installation, if CIFS-ECS sees that a computer is in a cluster, the CIFS-ECS 
setup process automatically loads a cluster resource DLL and registers the CIFS-ECS 
Resource DLL with the cluster. This creates a new Resource Type called “CIFS-ECS.” 
When installing in a cluster, it is important that CIFS-ECS be installed on all nodes of 
the cluster using the same installation path (usually: C:\Program Files\CIFS-ECS\).

No additional user configuration in CIFS-ECS is required to support running in a 
cluster. The administrator must configure the cluster server and create a resource 
group, but CIFS-ECS is able to analyze the cluster configuration to determine its role 
in the cluster and perform the appropriate actions. The administrator must follow a few 
simple rules:

1. The resource group must contain storage and network name resources. The 
CIFS-ECS resource must have both of those resources as dependents because it 
uses the dependency information to associate a cloud directory with the shared 
drive.

 If you select “Other Server” when creating a resource group, you can select 
CIFS-ECS from a list of resources and the dependencies are automatically 
created.

 If you select “File Server” when creating the cluster group, you must manually 
add the CIFS-ECS resource and set the correct dependencies.

2. The cluster group must be created and brought online before configuring 
CIFS-ECS. 

IMPORTANT

Ensure that the cluster group is running on the node on which you are configuring 
CIFS-ECS.



CIFS-ECS cluster support 55

Gateway Support

If the cluster group is not online and owned by the current CIFS-ECS node, you cannot 
configure CIFS-ECS because the shared disk is not available. It is impossible to 
configure CIFS-ECS without a drive to host the data. When specifying the cache 
directory:

◆ Note that the “Drive” field that specifies the “virtual” drive is always disabled if 
CIFS-ECS is installed in a cluster. When configuring CIFS-ECS in a cluster, use the 
Advanced dialog to specify a cache path on the shared disk.

◆ The shared disk must be a dependent of the CIFS-ECS resource.

Cluster configuration options

CIFS-ECS is supported on cluster groups with multiple storage resources or on 
multiple cluster groups as follows:

◆ A single cluster group containing multiple storage resources and multiple cloud 
drives

As previously noted, the “CIFS-ECS” resource must be dependent on a network 
name and a storage resource. You should never have the CIFS-ECS resource 
dependent on more than one storage resource. If there are multiple storage 
resources, you must have the same number of CIFS-ECS resources, each one 
dependent on one of the storage resources.

◆ Multiple cluster groups

Multiple cluster groups, each containing a network name, storage and CIFS-ECS 
resources may be created. Each of these groups can be assigned to different nodes 
to provide for an Active-Active configuration.

◆ Sharing a folder

In general, you should share the CIFS-ECS cache path folder so that remote clients 
have access to the data. When sharing the folder, be sure to add a dependency to 
the file share so that it is also dependent on the corresponding CIFS-ECS resource.

Cluster configuration best practices

Ensure that the following guidelines are met when configuring CIFS-ECS resources:

◆ The CIFS-ECS resource must have at least two dependencies: Network Name and 
a single Storage resource. It cannot be dependent on multiple storage resources.

◆ If there are multiple storage resources, and you require multiple cloud drives that 
reference the storage resources, you must have one CIFS-ECS resource for each 
storage resource.

◆ When creating a share, it must be dependent on the corresponding CIFS-ECS 
resource.

Configuring a cluster environment

Use this procedure to configure a cluster environment to support CIFS-ECS:

1. In the Cluster administrator application, right-click Services and Applications.
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2. Click Configure a Server or Application to start the configuration wizard. A list of 
supported services displays. 

3. Select File Server or Other Server. This al lows the CIFS-ECS files to be shared 
by the cluster. The wizard allows you to select storage, a network name, and an IP 
address. 

Additionally, if you selected Other Server, the wizard asks what other resources 
should be included in the group. 

4. If you selected Other Server in step 3, then select CIFS-ECS from the resources 
list.

5. If you selected File Server in step 3, add the CIFS-ECS resource. 

a. Right-click the created service and select Add Resource/CIFS-ECS. 

b. After it is added, right-click the CIFS-ECS resource and select Properties > 
Dependencies. 

c. Add the Network Name and Storage as dependencies.

6. Once the cluster group is created, bring the cluster group online.

7. Use the CIFS-ECS console to configure a cloud drive, as described in “Step 2: 
Configuring the CIFS-ECS folder” on page 9, while ensuring the following: 

 Ensure you are on the node that is the current owner of the resource group. If 
you are not, the shared drive does not exist and you cannot complete the 
configuration.

 In a cluster, ensure that the cache path defaults to a subfolder of the shared 
disk.

 In a cluster, CIFS-ECS enumerates all instances of the CIFS-ECS resources and 
looks at the dependent disks to create a default cache path. If multiple 
CIFS-ECS resources exist, a dialog appears listing all drives along with the 
associated CIFS-ECS resource name. You select the drive/resource to 
configure. A typical default path is:

S:\CIFS-ECS Data\New CIFS-ECS

S: is the shared drive and New CIFS-ECS is the CIFS-ECS resource name.

Note: This default path can be modified through the Advanced dialog if desired 
(during initial configuration only).

Note: Do not duplicate the configuration of the cloud drive on every node of the 
cluster. Only configure the cloud drive on the current owner node of the cluster 
group. Once the configuration is set on that one node, the configuration is 
written to the distributed cluster database. Whenever the cluster is brought 
online on any node, the CIFS-ECS configuration is read from the cluster 
database and set on that node. 

8. If enabled, configure the CIFS-ECS advanced options on each CIFS-ECS running 
on each node in the cluster. Use CIFS-ECS Console > Home > Options and refer 
to “Advanced options” on page 38 for details.
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The CIFS-ECS advanced options, which allow you to set logging, email, process, 
enterprise, and performance options, are not written to the distributed cluster 
database. 

Basic CIFS-ECS behavior in a cluster

When the resource group (or just the CIFS-ECS resource in a group) goes offline, that 
state is immediately visible in the CIFS-ECS Console. The green light for that 
CIFS-ECS definition goes off (no indicators display). Table 22 on page 57 summarizes 
the indicators:

The following rules apply:

◆ When a resource is brought offline, al l cloud drive definitions that reference the 
drive in that resource are disabled.

◆ When a resource is brought online, al l cloud drive definitions that reference the 
drive in that resource are enabled, and a recovery process is initiated.

Uninstall or upgrade for a cluster
An upgrade or uninstall of the CIFS-ECS on a system with Failover Cluster installed 
wil l generally require a reboot.

Table 22  Indicator colors and their descriptions  

Indicator Description

Green Enabled and connected to ECS.

Yellow Updates are paused.

Red Not connected to ECS.

None Disabled. This state is automatically entered if the resource goes offline. 
There is no way that an administrator can manually disable or enable a cloud 
definition.
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CHAPTER 4
CIFS-ECS CLI Commands

CLI commands are also available for installing and configuring the CIFS-ECS. These 
commands can be used in conjunction with or in place of the CIFS-ECS console 
installation and configuration processes. This chapter contains the following topics:

◆ About CIFS-ECS scripted installation and configuration ...................................... 60
◆ CIFS-ECS scripted installation on a local system................................................. 60
◆ CIFS-ECS remote installation ..............................................................................  61
◆ CIFS-ECS configuration using the CIFS-ECS_cli ................................................. 63
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About CIFS-ECS scripted installation and configuration
CIFS-ECS is easily installed and configured on a single-user basis using the console 
documented in “Getting Started with CIFS-ECS Tool” on page 5. However, in some 
cases, a CLI-based solution is desirable. An example is when you configure CIFS-ECS 
using the same repeatable installation/configuration process for remote configurations 
on a large number of systems.

CIFS-ECS provides the following executable files for scripted installation and 
configuration:

EMC-CIFS-ECS.<ver>_x64.exe (64-bit) — The CIFS-ECS setup package (normally 
executed and run through the installation wizard GUI by the user). The install 
parameters can be modified (for example to change the install directory) or can be run 
with a reduced or invisible UI. 

CIFS-ECS_Install.exe — A remote installation utility that is packaged with CIFS-ECS 
but that acts as a standalone executable that can be copied and used on any supported 
computer. 

CIFS-ECS_cli.exe — Installed with CIFS-ECS, al lows an administrator to configure 
CIFS-ECS using CLI commands. 

To automate the installation process, you can write a script that uses the 
CIFS-ECS_Install.exe and EMC-CIFS-ECS.<ver>_x64.exe. After CIFS-ECS is 
installed, use CIFS-ECS_cli.exe to configure it in a separate script.

CIFS-ECS scripted installation on a local system
CIFS-ECS creates an installation wrapper (EMC-CIFS-ECS.<ver>_x64.exe) around 
the Windows Installer (msiexec.exe) to support custom CIFS-ECS installation 
requirements but stil l utilize the Windows Installer options.

For a complete list of available Windows Installer options from your local system, type 
at the command prompt: msiexec.exe/? 

CIFS-ECS installer parameters

The syntax for the installer command is:

EMC-CIFS-ECS.<ver>_x64.exe [/L<languageID>] [/S] [/V"<msiexec 
parameters>"]
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In the following example, an administrator creates a script that installs CIFS-ECS, 
generates a full log (“/l*” Windows Installer option) to c:\install.log, and creates the 
basic CIFS-ECS user interface (“/qb” Windows Installer option).

EMC-CIFS-ECS.<ver>_x64.exe /V"/l*v c:\install.log /qb"

In this example, the administrator creates a script that installs CIFS-ECS silently 
(“/S”), generates a full log, creates the basic UI (“/qb”), and also changes the install 
directory to C:\CIFS-ECS.

EMC-CIFS-ECS.<ver>_x64.exe /S /V"/l*v c:\install.log /qb 
INSTALLDIR=c:\CIFS-ECS"

CIFS-ECS remote installation
CIFS-ECS provides a remote installation utility (CIFS-ECS_Install.exe) that is 
packaged with CIFS-ECS. The CIFS-ECS_Install.exe acts as a standalone executable 
that can be copied and used on any supported computer.

Table 23  Installer options for CLI  

Installer option Description

/L<languageID> Numeric language identifier. By default, the installer uses the 
language specified for the operating system on the local system.
To use a different language for the installer, specify this option. 
For example, /L1036 specifies the French language.
Depending on the CIFS-ECS version, the instal ler may not 
support al l languages. If supported, here are examples of 
numeric identifiers:
1033 English (US)
2052 Chinese (PRC)
1036 French (France)
1042 Korean (Korea)
1041 Japanese (Japan)
1031 German (Germany)
1049 Russian (Russia)
2058 Spanish (Latin America)
1040 Italian (Italy)
1046 Portuguese (Brazil)

/S Silent. Do not display initial dialogs. To also suppress Windows 
Installer dialogs, use: /S /V/qn

/V"< parameters>" Pass parameters to the Windows Installer. The double quotation 
marks are generally required since the parameters usually 
contain spaces. CIFS-ECS-specific properties allow you to 
change the paths for the installation and data directories or to 
designate the TCP/IP port:
INSTALLDIR=<path> 
DATADIR=<path>
TCPIPPORT=<port #>

For a complete list of parameters, type at the command prompt: 
msiexec.exe/? 
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Note: The remote installation utility CIFS-ECS_Install.exe is installed during 
CIFS-ECS installation on your local system. It is then available for use as a standalone 
executable.

During CIFS-ECS installation on your local system, the utility is installed to: 

C:\Program Files\CIFS-ECS\CIFS-ECS_Install.exe

Remote installer command

Syntax

CIFS-ECS_Install_Install <options> [<properties>]

Remote installer logging options

Syntax

/l[i|w|e|a|r|u|c|m|o|p|v|x|+|!|*] <LogFile>

Table 24  Remote installer options for CLI  

Remote installer option Description

/i <path to setup files> Install (UNC path or local path)

/x Uninstall

/u <domain\\user> Connect with specified 'domain\\user' (required)

[/a <password>] The password for the user specified in the /u parameter

[/r <remote server>] Remote server

[/p] Display progress

[/pv] Verbose progress (list actions)

Table 25  Remote installer logging options  (page 1 of 2)

Logging option Description

i Status messages

w Nonfatal warnings

e All error messages

a Start up of actions

r Action-specific records

u User requests

c Initial UI parameters

m Out-of-memory or fatal exit information

o Out-of-disk-space messages

p Terminal properties

v Verbose output
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Remote installer properties options

The command line supports any number of installer properties. The most commonly 
used property values that can be passed into the installer are described below.

CIFS-ECS configuration using the CIFS-ECS_cli
During installation, CIFS-ECS also installs the CIFS-ECS_cli, which allows you to 
configure CIFS-ECS through a CLI instead of through the CIFS-ECS console. The CLI 
communicates with the CIFS-ECS service using TCP/IP. Communications are 
authenticated, digital ly signed, and encrypted to prevent attacks and ensure privacy. 

If the target system is in the same domain, credentials are not typically required. If the 
target computer is in another domain, the CLI al lows you to specify credentials so the 
remote computer can successfully authenticate with the CLI process.

A single TCP/IP port is used for communications. If there are any firewalls between the 
CLI computer and the remote computer, the firewall must be configured to al low 
access for this port.

The syntax is:

CIFS-ECS_cli [<remote options>]  <command> [<options>]

IMPORTANT

The default path to the CIFS-ECS drive cache directory is C:\ProgramData\CIFS-ECS 
Data\<drive #>. When entering the path in CIFS-ECS CLI commands, remember to 
specify the path in double quotation marks since it contains spaces that are not 
al lowed in the command. For example: “C:\ProgramData\CIFS-ECS Data\Z_Drive”

x Extra debugging information

+ Append to existing log file

! Flush each line to the log

* Log all information, except for v and x options

/log <logfile> Equivalent of /l* <LogFile>

Table 25  Remote installer logging options  (page 2 of 2)

Logging option Description

Table 26  Remote instal ler properties option  

Properties option Description

PROPERTYNAME=”<value>” Pass parameters to the Windows Instal ler. The double quotation marks are 
generally required since the parameters usually contain spaces. The following 
CIFS-ECS-specific properties al low you to change the paths for the 
installation and data directories:
INSTALLDIR=<path> 
DATADIR=<path>
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CLI help

Access the CIFS-ECS CLI help that provides descriptions of al l command and options 
with the /? option:

CIFS-ECS_cli/?

Remote options

Remote options allow you to specify a remote computer name/IP address and user ID.

Command options

CIFS-ECS CLI commands allow you to list, add, modify, and delete hosts and drives, 
import and export CIFS-ECS configurations, collect log files, monitor the upload 
queue, display status, and list User Database entries.

Host command and options
The Host command allows you to list host entries, add a new host or modify an existing 
entry, delete a host, or test an entry to ensure connectivity. 

List option

List specified (or al l) host entries.

Syntax

CIFS-ECS_cli [<remote options>] Host [<name>] /list [<options>]

Example

>CIFS-ECS_cli Host /list /v
IS-1-001: ECS Test Host
  ed461c9bbecb43f58336bba602632c0e/1001
  HTTP:
    10.5.116.190
Geo2-002: QA Test Bed
  38716c9e66b24170a1c96084d6eb0df4/2001
  HTTP:

Table 27  Remote options used to specify a remote computer 

Remote option Description

/r <computername/IP> Optional: If not present, connect to the local computer.

/user <domain\account> Optional: If not present, connect using the user's login credentials.

/pass * | <password> Required if "/user" is specified. If "*", then prompt the user for the 
password.

Table 28  Host list options  

Command option Description

<name> Optional: Name of host entry. Lists the specified entry.
If <name> is not specified, displays a list of al l host entries. 

/v Optional: Lists all information about host entry.
If /v is not specified, each host entry is a single line with minimal 
information.



CIFS-ECS configuration using the CIFS-ECS_cli 65

CIFS-ECS CLI Commands

    10.6.144.151

Add/Modify option

Add a new host entry or modify an existing entry.

Syntax

CIFS-ECS_cli [<remote options>] Host <name> /add [<options>]
CIFS-ECS_cli [<remote options>] Host <name> /modify [<options>]

Delete option

Remove an existing host entry.

Syntax

CIFS-ECS_cli [<remote options>] Host <name> /delete [<options>]

If a host entry is currently referenced by a "Drive" definition, the host entry cannot be 
deleted.

Table 29  Host add or modify options  

Command option Description

<name> Name of host entry.

/description <description> Optional description.

/UserID <user ID> User ID for the ECS system (required for new entry). For 
ECS, this is the ECS Object User. 

/shared-secret <shared 
secret>

Shared Secret (required for new entry).

/http | /https Specify SSL or not. If this option is omitted, the default is 
/http.

/port <port #> Optionally, set which ports are used for HTTP / HTTPS 
instead of using the default settings (HTTP = 80; HTTPS = 
443). 

/cloud-server <IP or DNS 
name>

At least one is required. Multiple values are accepted.
For example: /cloud-server 1.2.3.4 /cloud-server 1.2.3.5

/proxy <proxy server> Optional, proxy server.

/proxyport <port #> If /proxy is specified, the port number is used.

/proxyuser <proxy user> If authentication is required by the proxy server, set user or 
domain\user.

/proxypass <proxy password> Password is required by proxy associated with proxy user.

/upstream-limit <KBytes-sec> Upload throttle value. If 0, no throttle.

/downstream-limit 
<KBytes-sec>

Download throttle value. If 0, no throttle.

Table 30  Host delete option  

Command option Description

<name> Name of host entry to delete (required).
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Drive command and options
The Drive command allows you to list CIFS-ECS virtual drive definitions, and to add, 
modify, or delete a virtual drive definition.

List option

List specified (or al l) CIFS-ECS definitions.

Syntax

CIFS-ECS_cli [<remote options>] Drive [<CIFS-ECS>] /list [<options>]

Example

>CIFS-ECS_cli Drive /list /v
O:\, C:\ProgramData\CIFS-ECS Data\O_Drive\
  Enabled
  Modify Wait Time (seconds): 60
  Access Wait Time (seconds): 120
  Update Wait Time (seconds): 60
  Open Wait Time (seconds): 120
  Cloud Host:     IS-1-001
      Bucket: 1001
Metadata Rules:
    Tag: GD-replicate jpg
       Value: .jpg
  

Add/Modify option

Add or modify the CIFS-ECS definition.

Syntax

CIFS-ECS_cli [<remote options>] Drive /add [<options>]
CIFS-ECS_cli [<remote options>] Drive <CIFS-ECS> /modify [<options>]

Table 31  Drive list options  

Command option Description

<drive or path> Optional: Virtual drive (such as "J" or "J:") or path to drive cache 
directory. Lists the definition for the specified drive.
If <drive> is not specified, display a list of al l CIFS-ECS virtual 
drive definitions. 

/v Optional: Lists all information about the drive entry.
If /v is not specified, each drive entry is a single line with minimal 
information.

Table 32  Drive add and modify options  (page 1 of 2)

Command option Description add/modify

<drive or path> Virtual drive (such as "J" or "J:") or path to drive 
cache directory.

/modify only

/drive <driveletter> Creates a new drive. Specify the virtual drive letter 
to create (if available).

/add only

/newdrive Creates a new drive without specifying a drive 
letter (default).

/add only
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Delete option

Remove an existing virtual drive definition.

Syntax

CIFS-ECS_cli [<remote options>] Drive <drive or path> /delete 
[<options>]

/nonewdrive Do not create a virtual drive. Files are accessed 
through the cache path.

/add only

/cache <cache path> Backing path. If not specified, a path off the data 
directory wil l be used. Either /letter or /cache 
must be specified.

/add only

/description <description> Description. Applies to 
both. 

/fileexclude <excludes> Per-file excludes, separated by ';' (*.tmp for 
example).

Applies to 
both. 

/direxclude <excludes> Per-directory excludes, separated by ';'. Applies to 
both. 

/pathexcludes 
<excludes>

Excludes from the root of the cache directory (or 
virtual drive). For example: 
filetoexclude.txt;dirtoexclude\filetoexclude.txt

Applies to 
both. 

/AccessTime <seconds> How long a time a file is not accessed before 
replacing the file with a stub.

Applies to 
both. 

/ModifyTime <seconds> How long a time a file is not modified before 
uploading the file to the cloud.

Applies to 
both. 

/AccessUploadTime 
<seconds>

How long to wait before replacing a local file with a 
stub.

Applies to 
both. 

/AccessRestoreTime 
<seconds>

How long to wait before replacing a local file with a 
stub after restore.

Applies to 
both. 

/OpenTme <seconds> If a file is open for longer than this specified value 
(in seconds), take a shadow copy of the file and 
upload it.

Applies to 
both. 

/UpdateTime <seconds> How long CIFS-ECS waits before checking the 
cloud for updated content.

Applies to 
both. 

/Host <host_id> Specify a host entry (created with "CIFS-ECS_cli 
Host /add") location where the data is to be 
uploaded.

/add only

/bucket <bucket name> Bucket used on the Host server. /add only

Table 32  Drive add and modify options  (page 2 of 2)

Command option Description add/modify

Table 33  Drive delete option  

Command option Description

<drive or path> Virtual drive (such as "J" or "J:") or path to drive cache 
directory.
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Add and remove metadata commands and options
Add metadata tags to implement ECS policies. You can also remove metadata tags.

Syntax

CIFS-ECS_cli [<remote options>] Drive <drive or path> /addmd /tag 
<tagname> /value <value> [/path <directory>] [/subdirs] [/pattern 
<filename pattern>]

CIFS-ECS_cli [<remote options>] Drive <drive or path> /removemd [/tag 
<tagname>] [/all]

ExportConfig command and options
Write the entire configuration to a file.

Syntax

CIFS-ECS_cli [<remote options>] ExportConfig <options>

Force command and options
Force CIFS-ECS to start an upload.

Table 34  Drive add and remove metadata options  

Add or remove metadata 
option Description

Drive <drive or path> Virtual drive (such as "J" or "J:") or path to drive cache 
directory.

/addmd | /removemd Add or remove a metadata tag.

/tag <tagname> The name of the metadata tag.

/value <value> The value associated with the metadata tag.

/path <directory> The path to the directory containing the files that wil l have the 
metadata tags applied to them. 

/subdirs Apply the metadata tags to al l subdirectories in the directory 
listed previously in the command.

/pattern <filename 
pattern>

Specify a subset of files (for example based on .txt or .doc) to 
which to apply the metadata tag.

/all Remove al l metadata tags.

Table 35  ExportConfig options  

ExportConfig option Description

/pass *|<password> Optional password used to encrypt the configuration. If "*" is 
specified, then prompt the user for the password.

<path to config file> The path to a file that is created containing the configuration 
(required).
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Syntax

CIFS-ECS_cli [<remote options>] Force <path or drive>

ImportConfig command and options
Restore the configuration from a file.

Syntax

CIFS-ECS_cli [<remote options>] ImportConfig <options>

Version command and options
Display the version of CIFS-ECS.

Syntax

CIFS-ECS_cli [<remote options>] Version

Log command and options
Display a portion of the CIFS-ECS logs.

Syntax

CIFS-ECS_cli [<remote options>] Log  <options>

Table 36  Force option  

Force option Description

<path or drive> The path to the drive (or the drive) that you want to immediately 
force an upload on (as opposed to waiting for the CIFS-ECS 
upload wait time to expire).

Table 37  ImportConfig options  

ImportConfig option Description

/pass *|<password> Optional password used to decrypt the configuration. If "*" is 
specified, then prompt the user for the password. If this is not 
specified but the configuration is encrypted, it wil l prompt for a 
password.

<path to config file> The path to a file containing the configuration.

Table 38  Log options  

Log options Description

/info | /noinfo Include or do not include informational log messages. If this 
option is omitted, the default is /noinfo.

/warning | /nowarning Include or do not include warning log messages.

/severe | /nosevere Include or do not include severe log messages.

/error Include error log messages.

/start <time> Specify start time. If this option is omitted, start from the 
beginning of the log.

/end <time> Specify end time. If this option is omitted, go to the end of the 
log.

/v Verbose. Include all information for each log message.
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The format for start and end <time> values is:

<time> = “[<Month>/<Day>/<Year>] <Hour>:<Minute> [AM/PM]” 

depending on locale. For example, in much of Europe, this may be in a Day/Month/Year 
format. The <time> value must be enclosed in double quotation marks if it includes an 
embedded space.

Enter CIFS-ECS_cli /? to display usage and show the syntax for time and date for the 
current locale.

UploadQueue command and options
The CLI UploadQueue feature allows an administrator to generate a list of al l files 
currently being transferred as well as those awaiting transfer. The files display in the 
order of the queue with the files at the top scheduled to be transferred last. Files listed 
with an asterisk are currently being transferred.

Syntax

CIFS-ECS_cli UploadQueue [/out <file>] [/utf8] [/utf16]

Example

In the following example, the UploadQueue command is used to send the current 
queue to a file named “Test1” in the “My Documents” folder for user1:

C:\Users\user1>CIFS-ECS_cli UploadQueue /out “My Documents\Test1” 
/utf8

C:\Users\user1>

Each line of the output file provides the CIFS-ECS letter, file path, and file name. The 
following example shows the current queue of files awaiting upload and those 
currently being transferred (with an asterisk):

F:\Test Files\Zipped\Reading Materials.zip
F:\Test Files\Project\testplan.doc
* F:\Test Files\Sample Pdf\Network Storage Topology.pdf
* F:\Test Files\Sample Pictures\Flower\Tulips.jpg
* F:\Test Files\Sample Videos\Wildlife.wmv
* F:\Test Files\Sample Word\Test Plan0.3.docx

Pause/Resume upload command and options
Pause or resume the upload of the specified CIFS-ECS.

Table 39  UploadQueue options  

Command option Description

/out <file> The location to send the generated file. If the /out <file> option 
is not specified, the list is sent to the console.

/utf8
/utf16

Encode the list in UTF-8.
Encode the list in UTF-16LE.
If neither is specified, the file is formatted in ASCII.
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Syntax

CIFS-ECS_cli [<remote options>] Pause|Resume <drive or path>

Status command and options
Display the current status of the CIFS-ECS.

Syntax

CIFS-ECS_cli [<remote options>] Status  [<drive or path>]

This displays the status of each specified CIFS-ECS. If none is specified, it displays the 
status of al l CIFS-ECSs.

The Connection status provides: 

◆ If connected: ECS version

◆ If not connected: Last connection time, last connection error.

Example

 
Two examples follow. The first example shows no error. 

C:\Users\Administrator\Desktop>CIFS-ECS_cli status
Host: ECS Test Drive, Path: C:\ProgramData\CIFS-ECS Data\F_Drive\

This second example shows a connection error:

C:\Users\Administrator\Desktop>CIFS-ECS_cli status
Host: ECS Test Drive, Path: C:\ProgramData\CIFS-ECS Data\F_Drive\
Disconnected - Last Error: 12002 - The operation timed out
Disconnect time: 10/23/2015 9:21 AM

UserDB command and options
The UserDB command allows you to list User Database entries, append new entries, or 
delete existing entries.

List option

Output a CSV (comma separated value) file of al l entries in the user database.

Syntax

CIFS-ECS_cli [<remote options>] UserDB /list <filename>

Table 40  Upload pause or resume option  

Pause/Resume option Description

<drive or path> This is either the virtual Drive letter (J:) or the path to the cache 
directory (for example “C:\ProgramData\CIFS-ECS Data\E_Drive”).

Table 41  Status option  

Status option Description

<drive or path> This is either the virtual Drive letter (J:) or the path to the cache 
directory.
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Append option

Take as input a list of Window account/S3 user pairs. Optionally include the ECS S3 
User ID. For each user specified, add it to the database. If the key is not specified, then 
SYSTEM_ADMIN credentials must have been supplied so it can obtain the key from 
the server.

Syntax

CIFS-ECS_cli [<remote options>] UserDB /append <filename>

Delete option

Take as input a list of Windows account/S3 user pairs. All matching users in the list are 
deleted.

Syntax

CIFS-ECS_cli [<remote options>] UserDB /delete <filename>
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